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Preface 
 

PREFACE 
 
General 
 
Since the first report of DNA amplification using the process known as polymerase chain reaction (PCR) in 1985, many 
advances and modifications have been made to the basic method. PCR is an in vitro method for the enzymatic synthesis 
of specific DNA sequences, using two oligonucleotide primers that hybridize to opposite strands and flank the region of 
interest in the target DNA. A repetitive series of cycles involving template denaturation, primer annealing, and extension 
of the annealed primers by DNA polymerase results in the exponential accumulation of a specific fragment whose 
termini are defined by the 5’ ends of the primers. Because the primer extension products synthesized in one cycle can 
serve as a template in the next, the number of target DNA copies approximately doubles at every cycle. Thus, 20 cycles 
of PCR yields about a million-fold (220) amplification. The original PCR method, invented by Kary Mullis, was used to 
diagnose prenatal sickle-cell anemia.1,3 With advances in the polymerase chain reaction process, analyzing forensic 
casework has been made more efficient. The ability to extract and type DNA from forensic evidentiary samples has 
revolutionized the field of forensic DNA. Previously, genetic marker typing was limited to the analysis of blood group 
markers and soluble polymorphic protein markers. Because the number of suitable markers expressed in particular fluids 
and tissues is relatively small, and because mixtures of fluids cannot be separated for conventional genetic marker 
typing, a suspect frequently cannot be included or excluded as a fluid donor in a case. However, the development of 
methods to extract DNA from virtually all biological specimens has greatly expanded the potential for individual 
identification.3 
 
Taq DNA Polymerase 
 
Initially, PCR amplification used the Klenow fragment of E. coli DNA polymerase I to extend the annealed primers. This 
enzyme was inactivated by the high temperatures required to separate the two DNA strands at the outset of each PCR 
cycle. Fresh enzyme had to be added constantly during every cycle. To make the process more time efficient molecular 
biologists began to use an enzyme from a thermophilic eubacterial microorganism, Thermus aquaticus (Taq), capable of 
growth at 70°C-75°C.1,2 Although Taq DNA polymerase has a very limited ability to synthesize DNA above 90°C, the 
enzyme is relatively stable and is not denatured irreversibly by exposure to high temperatures. Preliminary results 
indicate retention of 65% activity after a 50-cycle PCR amplification when the upper limit temperature was 95°C.1 Under 
normal reaction conditions, the amount of Taq DNA polymerase becomes limiting after 25-30 cycles of amplification.4 
Two forms of Taq DNA polymerase that are now available are both a genetically engineered form of the native enzyme 
synthesized in E. coli. One of these DNA polymerases, AmpliTaq GoldTM (Perkin-Elmer), is provided in an inactive 
state. Heat activates the enzyme. This feature allows flexibility in reaction setup. Both forms of the polymerase carry a 
5’→ 3’ polymerization-dependent exonuclease activity, but they lack a 3’ → 5’ exonuclease activity.4,5 
 
PCR Primers 
 
In order to amplify a sequence of DNA, oligonucleotide primers flanking the target DNA sequence of interest are used. 
These oligonucleotide primers typically have different sequences and are complementary to sequences that lie on 
opposite strands of the template DNA with their 3’ ends oriented toward each other. The template DNA is first denatured 
by heating in the presence of a large molar excess of each of the two oligonucleotide primers and the four dNTPs. The 
reaction is then cooled to a temperature that allows the oligonucleotide primers to anneal to their target sequences, after 
which the annealing primers are extended with the enzyme Thermus aquaticus (Taq) DNA polymerase in an automated 
series of heating and cooling cycles. With each cycle the DNA will approximately double the number of copies. The 
primers are responsible for the sequence specificity of the PCR reaction. Typically the length of the primers used in the 
PCR amplification should be at least 16 nucleotides (preferably 20 to 30 nucleotides) in length and single stranded.4 
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Introduction 
 

INTRODUCTION 
 
An important development in the field of forensic science was the introduction of DNA typing systems for the analysis 
of biological samples. The RFLP-based typing system is highly informative, but requires greater than 50 ng of high 
molecular weight DNA and involves the use of multiple radioactive/chemiluminescent probes to obtain a result. An 
alternative approach to forensic DNA typing is based on the powerful polymerase chain reaction (PCR) technology, 
which does not require the use of radioactivity 1,2. Specific regions of the genome containing either sequence 
polymorphisms or length polymorphisms are amplified from minute amounts of DNA. Alleles which have been 
amplified and contain sequence differences, single nucleotide polymorphisms (SNPs) may be typed using the "reverse 
dot blot technology and other approaches.3 Amplified alleles containing length variations, such as short tandem repeats 
(STRs) and amplified fragment length polymorphisms (AMP-FLPs) may be typed by polyacyrlamide gel or capillary 
electrophoresis. 
 
STR loci consist of short, repetitive sequence elements of 3 to 7 base pairs in length.4 These abundant repeats are well 
distributed throughout the human genome and are a rich source of highly polymorphic markers which may be detected 
using the polymerase chain reaction. The alleles for these loci are differentiated by the number of copies of the repeat 
sequence contained within the amplified region and are distinguished from one another using radioactive, silver stain, or 
fluorescence detection following electrophoresis. In the capillary system, fluorescence detection of the amplified product 
is accomplished during the electrophoresis. The PowerPlex® 16 System provides a rapid, non-isotopic method which can 
be used to evaluate very small amounts of human DNA. STR typing is more tolerant of the use of degraded DNA 
templates than other typing methods because the amplification products are less than 500 bp long, much smaller than the 
material detected with AMP-FLP5,6 or VNTR7,8 analysis.  
 
The PowerPlex® 16 System allows the co-amplification and four-color detection of sixteen loci (fifteen STR loci and 
Amelogenin) and the internal lane standard (ILS 600). The PowerPlex® 16 System contains the loci Penta E, D18S51, 
D21S11, TH01, D3S1358, FGA, TPOX, D8S1179, vWA, Amelogenin, Penta D, CSF1PO, D16S539, D7S820, 
D13S317, and D5S818. In the system, the primer sets specific for Penta E, D18S51, D21S11, TH01, and D3S1358, 
contain one primer of each pair that is labeled with fluorescein (FL); the primer sets specific for the following loci: FGA, 
TPOX, D8S1179, vWA, and Amelogenin contain one primer of each pair that is labeled with carboxy-
tetramethylrhodamine (TMR); and the primer sets specific for the following loci: Penta D, CSF1PO, D16S539, D7S820, 
D13S317, and D5S818 contain one primer of each pair that is labeled with 6-carboxy-4’,5’-dichloro 2’,7’ – 
dimethoxyfluorescein (JOE). All sixteen loci are amplified simultaneously in a single tube or plate well and analyzed in 
a single capillary9. 
 
Capillary electrophoresis involves the use of acrylamide polymers packaged into glass capillaries for separating 
fragments of DNA of varying length depending on the function for which it is used (i.e. sequencing versus fragment 
analysis). The acylamide polymers used are not cross-linked, however DNA fragments are retarded in proportion to the 
length of the molecule in a manner similar to conventional electrophoresis using cross-linked polyacrylamide gel. The 
internal diameter of the capillaries used is small, 50 μm.10 The narrow capillary enables the application of high electric 
fields, and thus faster run times, without overheating problems associated with the high voltages used since the surface 
area is maximized allowing for easier heat dissipation. 
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1 Isolation of DNA 
 

1 ISOLATION OF DNA 
 
It is important to handle all samples aseptically to prevent contamination by extraneous DNA. It is also important to 
prepare databank samples in a separate lab space from casework samples to prevent possible cross-contamination. 
 
NOTE: For tracking purposes the samples will be listed on the worksheet in the order in which they were 

processed/handled. The samples will be maintained in the same order throughout the rest of the analysis. All 
samples will be processed in accordance with the procedures and policies outlined in the Commonwealth of 
Virginia Department of Forensic Science Forensic Biology Section Procedure Manual, Section I, General 
Documentation and Evidence Handling Requirements, Chapter 3, Contamination Prevention and Detection 
Procedures, and Section VI, Quality Assurance Program DNA Typing of Biological Materials, Chapter 6, 
Dedicated PCR Facilities. 

 
Special Precautions: 
 
• Manual or robotic DNA extraction and PCR setup of samples will be performed in a separate lab space from 

casework samples. This helps to prevent potential cross-contamination between evidence samples and databank 
samples. 

• Disposable gloves will be used at all times. Gloves will be changed frequently to avoid sample-to-sample 
contamination with DNA and whenever moving between work areas. Gloves will be changed if suspected direct 
contamination has occurred from the sample DNA. 

• To minimize transferring DNA to the disposable gloves, ensure that each tube has been pulse-spun in a 
microcentrifuge to remove any liquid from the cap of the tube. If the sample comes in contact with the disposable 
glove, change gloves before proceeding to the next sample tube. 

• Scissors, tweezers and hole puncher will be thoroughly cleaned with a 10% solution of bleach or a solution that will 
remove/degrade the DNA after cutting each sample. Subsequently use isopropanol to remove the residue left by the 
chemicals, using special care to remove all residue left on surfaces.  

• A clean cutting surface will be used for each sample. 
• Disposable plugged pipette tips and microcentrifuge tubes will be used. 
• Pipette tips will be changed between samples. 
• Reagents will be stored in small quantities to reduce the risk of possible contamination to the stock solution. 
• To avoid splashing and minimize aerosols, all liquid will be centrifuged to the bottom of the closed tube before the 

tube is opened. 
• Reagent blank controls will be included with each set of DNA extractions to check for the presence of 

contaminating DNA in the reagents. 
• All work surfaces will be thoroughly cleaned with a 10% bleach solution or a solution that will remove/degrade the 

DNA. Subsequently use isopropanol to remove the residue left by the chemicals, using special care to remove all 
residue left on surfaces before setting up the DNA Extraction Work Area.  

• A dedicated lab coat will be worn for pre-amplification sample handling when working in the DNA Extraction Work 
Area. 

• A dedicated disposable lab coat will be worn when working with amplified DNA in the PCR Post Amplification 
Work Area. NOTE: the disposable lab coats are discarded in the post amplification room as necessary.  

 
1.1 Technical Notes 

 
1.1.1 The QIAamp® extraction procedure uses spin columns to extract/purify DNA from buccal samples and 

dried blood stains. The QIAGEN® AL lysis buffer, included in the QIAamp® extraction kit, is a 
guanidine-based buffer. The guanidine helps to set up the binding conditions needed for the DNA to 
adhere to the spin column membrane. The QIAGEN® AL lysis buffer also contains a detergent to rupture 
leukocyte nuclear membranes which exposes the nucleic acids. 

 
1.1.2 The QIAGEN® protease is similar to, but less stringent than ProK, and serves the same purpose for the 

breakdown of proteins into their constituent amino acids. The DNA yield reaches a maximum after lysis 
for 10 min at 560 C. Longer incubation times have no effect on the overall yield of the purified DNA. 
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1 Isolation of DNA 
 

1.1.3 The QIAGEN® AW1 wash buffer is an ethanol-based stringent wash solution containing a low 
concentration of guanidine. This wash step removes any non-specific binding to the spin column 
membrane. 

 
1.1.4 The QIAGEN® AW2 wash buffer is a Tris-based solution containing ethanol which will wash away any 

salts that are present. 
 
1.1.5 The QIAGEN® AE elution buffer is a Tris-EDTA solution which elutes the DNA attached to the 

membrane and serves as a stable storage medium. 
 
1.1.6 A random sample will be run with each set of convicted offender and arrestee sample extractions to serve 

as a verification that the samples are successfully being entered into Combined DNA Index System 
(CODIS) and the search algorithm is working properly. This sample serves as an internal laboratory 
control since the DNA profile is not known to the Data Bank analyst and must be verified by the State 
CODIS Administrator or designee prior to the sizing data being considered acceptable. If a sample must 
be re-extracted a new random sample must be extracted along with the sample. 

 
1.1.7 Routinely the QIAGEN BioRobot® UNIVERSAL SYSTEM is used to isolate DNA from convicted 

offenders blood/buccal or arrestee buccal samples in accordance with the procedures manual. However, 
when necessary convicted offender blood/buccal and arrestee buccal samples may also be extracted using 
the QIAamp® Extraction Procedure, or the QIAamp® 96 Well Extraction Procedure. The Organic 
Extraction Method for Bloodstains and Tissue, and/or the DNA IQ Extraction Method for Buccal Cell 
Type Samples and Bloodstains may also be used in accordance with the Commonwealth of Virginia 
Department of Forensic Science Forensic Biology Section Procedures Manual, Section III – Fluorescent 
Detection PCR-Based STR DNA Protocol: Powerplex® 16 System. 

 
1.1.8 The organic, QIAGEN®, and DNA IQ Extraction methods will isolate DNA from both human and non-

human DNA. However, only the higher primate specific DNA will be amplified during the subsequent 
processing steps.  

 
1.2 Equipment  

 
1.2.1 Heat block or incubator, 56 oC 

 
1.2.2 Heat block or incubator, 70 oC 

 
1.2.3 Microcentrifuge 

 
1.2.4 Vortex mixer 

 
1.2.5 Tweezers 

 
1.2.6 Microcentrifuge tube rack 

 
1.2.7 Pipettes - 10 µL, 20 µL, 100 µL, 200 µL, 1000 µL 

 
1.2.8 8 – Channel Pipette – Range 0.5 µL to 10 µL (for QIAamp® extraction procedure)  

 
1.2.9 Refrigerator/Freezer 

 
1.2.10 Incubator, 70 oC (for QIAamp® extraction procedure) 

 
1.2.11 Hole punch (for QIAamp® extraction procedure from dried blood stains) 

 
1.2.12 Centrifuge, equipped with a microplate rotor (for QIAamp® extraction procedure) 

 
1.2.13 Plate orientation adapter for centrifuge (for QIAamp® extraction procedure) 
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1 Isolation of DNA 
 

1.3 Materials 
 

1.3.1 Microcentrifuge tubes, 1.5 mL 
 

1.3.2 Transfer pipettes 
 

1.3.3 Sterile ART tips for pipettes, 10 µL, 20 µL, 100 µL, 200 µL, and 1000 µL 
 

1.3.4 Microcentrifuge tube lids 
 

1.3.5 Kimwipes 
 

1.3.6 Gloves 
 

1.3.7 QAamp® spin columns 
 

1.3.8 QIAamp® 2-mL collection tubes 
 

1.3.9 Round well block (supplied with QIAamp 96 DNA Blood Kit) 
 

1.3.10 8-strip caps for use with the round well block (supplied with QIAamp 96 DNA Blood Kit) 
 

1.3.11 Microplate adhesive tape (supplied with QIAamp 96 DNA Blood Kit) 
 

1.3.12 Airpore tape (supplied with QIAamp 96 DNA Blood Kit) 
 

1.3.13 QIAamp 96 plate (supplied with QIAamp 96 DNA Blood Kit) 
 

1.3.14 S-block (supplied with QIAamp 96 DNA Blood Kit) 
 

1.3.15 Collection tube rack (supplied with QIAamp 96 DNA Blood Kit) 
 
1.4 Reagents 

 
1.4.1 Isopropyl Alcohol 

 
1.4.2 95% Ethanol/Reagent Grade (use with the QIAamp® blood extraction procedure) 

 
1.4.3 1X phosphate-buffered saline (PBS), pH 7.2 (for DNA extraction from blood/buccal samples) 

 
1.4.4 QIAGEN® protease (for DNA extraction from blood/buccal samples) 

 
1.4.5 QIAGEN® AL lysis buffer (for DNA extraction from blood/buccal samples) 

 
1.4.6 QIAGEN® AW1 wash buffer (for DNA extraction from blood/buccal samples) 

 
1.4.7 QIAGEN® AW2 wash buffer (for DNA extraction from blood/buccal samples) 

 
1.4.8 QIAGEN® AE elution buffer (for DNA extraction from blood/buccal samples) 

 
1.5 QIAamp® Extraction Procedure– Arrestee and Offender Samples 
 

NOTE:  Process a reagent blank and random sample along with each set of samples.  
 
1.5.1 Dried blood stains/buccal: Cut a 3 - 5 mm2 blood stain/buccal or using a hole puncher, punch one hole 

from the dried blood stain/buccal and transfer to a labeled 1.5 mL microcentrifuge tube using tweezers. If 
a hole punch is used, the hole punch should be cleaned between each punch using a Kimwipe and 10% 
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1 Isolation of DNA 
 

bleach then followed by isopropanol. Add 180 µL PBS buffer to each tube and then pulse spin to force 
the blood stain/buccal into the buffer. Incubate at 56 °C for ten minutes, then proceed to step 1.5.2. 

 
1.5.2 Add 20 µL of the QIAGEN® protease to each tube and vortex for 15 seconds to thoroughly mix the 

sample. 
 

WARNING! 
The QIAGEN® AL lysis contains Guanidine Hydrochloride. This chemical will produce chlorine 

gas when mixed with bleach. When cleaning the counter tops after using the QIAGEN® extraction 
method wash the counter top first with water, then isopropanol, followed by a 10% bleach solution 

to disinfect the area. 
 

1.5.3 Add 200 µL of the QIAGEN® AL lysis buffer to each tube. Vortex the tube for 15 seconds to thoroughly 
mix the sample. 

 
1.5.4 Incubate the tube in a 56 °C heat block for 10 minutes. 

 
1.5.5 Place the tube into a microcentrifuge and pulse spin the sample to remove condensation from lid. 

 
1.5.6 Add 200 µL 95% ethanol to each tube. Vortex the tube for 15 seconds to thoroughly mix the sample. 

 
1.5.7 Place the tube into a microcentrifuge and pulse spin the sample to remove condensation from lid. 

 
1.5.8 Transfer the supernatant from the tube to a labeled QIAamp® spin column that is inside of a 2.0 mL 

collection tube. Centrifuge the sample for 1 minute at 8,000 rpm. Be careful not to apply the sample to 
the rim of the spin column. Sample that has been deposited on the rim during the centrifugation will be 
transferred from the tube to the inside of the microcentrifuge. 

 
1.5.9 Discard the 2.0 mL collection tube containing the filtrate and place the QIAamp® spin column into a 

clean 2.0 mL collection tube. 
 

1.5.10 Add 500 µL of the QIAGEN® AW1 wash buffer and centrifuge for 1 minute at 8,000 rpm. 
 

1.5.11 Discard the 2.0 mL collection tube containing the filtrate and place the QIAamp® spin column into a 
clean 2.0 mL collection tube. 

 
1.5.12 Add 500 µL of the QIAGEN® AW2 wash buffer and centrifuge for 3.5 minutes at 13,200 rpm. 

 
1.5.13 Discard the 2.0 mL collection tube containing the filtrate and place the QIAamp® spin column into a 

clean, labeled 1.5 mL microcentrifuge tube. 
 

NOTE:  Use capless tubes or remove the caps from the tubes before centrifugation. 
 

1.5.14 Add 50 µL of the QIAGEN® AE Elution Buffer or Type 1 water to each QIAamp® spin column. 
 

1.5.15 Incubate the sample at room temperature for 1 minute. 
 

1.5.16 Place the 1.5 mL microcentrifuge tube containing the QIAamp® spin column into a microcentrifuge and 
spin for 1 minute at 8,000 rpm. 

 
1.5.17 Discard the QIAamp® spin column and cap the 1.5 mL microcentrifuge tube containing the extracted 

DNA sample. Extracted DNA samples should be stored at 2 to 8 °C for a few days or at -20 °C for 
extended periods. 

 
1.5.18 Proceed to Section 2, PCR Amplification. 
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1 Isolation of DNA 
 

1.6 QIAamp® 96 Well Extraction Procedure – Arrestee and Offender Samples 
 

NOTE:  Process a reagent blank and random sample along with each set of samples.  
 

1.6.1 Dried blood stains and/or buccal samples: Using a 6 mm2 hole puncher, punch one hole from the dried 
blood stain onto a Kimwipe. Using tweezers carefully fold the punch in half and then transfer to the 
appropriate position in the 96 well round well block. If a hole punch is used, the hole punch and 
tweezers should be cleaned between each punch using a Kimwipe and 10% bleach then followed by 
isopropanol. Add 195 µL PBS buffer to each of the wells, then cap the wells with an 8-strip cap. Pulse 
spin the 96 well round well block to force the punch into the buffer. Incubate at 70 °C in an oven for one 
hour. Place an acrylic block on top of the plate to prevent the caps from popping off. Once incubation is 
complete, pulse spin the 96 well round well block to remove condensation from the caps, then proceed to 
step 1.6.2. 

 
NOTE: When the procedure makes reference to pulse spinning the sample(s), allow the centrifuge to 

reach approximately 3,000 rpm and then turn off the centrifuge and allow the rotor to come to 
rest. 

 
1.6.2 Add 20 µL of the QIAGEN® protease to each well. Cap all wells and shake the 96 well round well block 

using two hands to thoroughly mix the samples. Pulse spin the 96 well round well block to remove 
condensation from the caps. 

 
WARNING! 

The QIAGEN® AL lysis buffer contains Guanidine Hydrochloride. This chemical will produce 
chlorine gas when mixed with bleach. When cleaning the counter tops after using the QIAGEN® 
extraction method wash the counter top first with water, then isopropanol, followed by a 10% 

bleach solution to disinfect the area. 
 

1.6.3 Add 200 µL of the QIAGEN® AL lysis buffer to each well. Cap each well, then using two hands shake 
the 96 well round well block for 15 seconds to thoroughly mix the samples.  

 
1.6.4 Incubate the 96 well round well block in a 70 °C incubator for 10 minutes. Place an acrylic block on top 

of the round well block to prevent the caps from opening. 
 
1.6.5 Place the 96 well round well block into a centrifuge with a plate rotor and pulse spin the samples to 

remove condensation from lid. 
 
1.6.6 Add 200 µL 95% ethanol to each well. Seal the wells using new caps for the round well blocks. Shake 

using two hands the 96 well round well block for 15 seconds to thoroughly mix the samples. 
 
1.6.7 Place the 96 well round well block into a centrifuge with a plate rotor and pulse spin the samples to 

remove condensation from cap. 
 
1.6.8 Place a QIAamp 96 well plate on top of an S-block. Mark the plate on the side for identification. 
 
1.6.9 Transfer the supernatant from the round well block to the corresponding well of the QIAamp® 96 well 

plate. Be careful not to apply the sample to the rim of QIAamp® 96 well plate. Sample that has been 
deposited on the rim may cross contaminate other samples. 

 
1.6.10 Seal the QIAamp 96 well plate with an airpore tape sheet. Load the S-block and QIAamp 96 well plate 

into the centrifuge carrier, then place the carrier into the rotor basket. Centrifuge the samples for 4 
minutes at approximately 6,000 rpm. 

 
1.6.11 Remove the airpore tape sheet and add 500 µL of the QIAGEN® AW1 wash buffer to each well. 
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1 Isolation of DNA 
 

1.6.12 Seal the QIAamp 96 well plate with an airpore tape sheet. Load the S-block and the QIAamp 96 well 
plate into the centrifuge carrier, then place the carrier into the rotor basket. Centrifuge the samples for 2 
minutes at approximately 6,000 rpm. 

 
1.6.13 Remove the airpore tape sheet and add 500 µL of the QIAGEN® AW2 wash buffer to each well. 
 
1.6.14 Seal the QIAamp 96 well plate with an airpore tape sheet. Load the S-block and the QIAamp 96 well 

plate into the centrifuge carrier, then place the carrier into the rotor basket. Centrifuge the samples for 15 
minutes at approximately 6,000 rpm. 

 
NOTE: The heat generated during centrifugation allows for evaporation of any residual ethanol on the 

membrane. 
 

1.6.15 Place the black orientation adapter ring on top of a rack of collection tubes, then place the QIAamp 96 
well plate on top of the adapter. Ensure the pieces fit snugly together. IF THE PIECES DO NOT FIT 
SNUGLY, CHECK THE ORIENTATION OF THE ADAPTER. 

 
1.6.16 To elute the DNA, add 50 µL of the QIAGEN® AE Buffer or Type 1 water to each well. Seal the 

QIAamp 96 well plate with an airpore tape sheet and incubate for 1 minute at room temperature. 
 
1.6.17 Load the plate combination into the centrifuge carrier, then place the carrier into the rotor bucket. 

Centrifuge the samples for 4 minutes at approximately 6,000 rpm. 
 

NOTE:  If a partial plate was processed, seal the used wells with adhesive tape and label “used”. 
 
1.6.18 Seal the wells of the collection tubes using the 8-strip caps. Label tubes appropriately. Plates of extracted 

DNA samples should be stored at 2 to 8 °C for a few days or at -20 °C for extended periods. 
 
1.6.19 Proceed to Section 2, PCR Amplification.
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2 PCR Amplification 
 

2 PCR AMPLIFICATION 
 
2.1 Technical Notes 

 
2.1.1 Taq DNA Polymerase, purified from Thermus aquaticus, attaches nucleotides in a 5’--->3’ direction to 

extend the DNA chain. 
 

2.1.2 The PowerPlex® 16 System contains 16 sets of primers and allows for the co-amplification and three-
color detection of 16 loci (15 STR loci and Amelogenin), which include the FGA, TPOX, D8S1179, 
vWA, Amelogenin, Penta E, D18S51, D21S11, TH01, D3S1358, Penta D, CSF1PO, D16S539, D7S820, 
D13S317, and D5S818 loci 

 
2.1.3 A random sample will be run with each set of convicted offender and arrestee sample amplifications to 

serve as a verification that the samples are successfully being entered into Combined DNA Index System 
(CODIS) and the search algorithm is working properly. 

 
2.1.4 If a sample must be re-amplified, providing that the random sample has amplified, the random sample 

does not need to be re-amplified. However, the Control DNA (positive amplification control) and 
negative amplification control must be amplified with the re-amplified sample. 

 
2.2 Equipment 

 
2.2.1 Thermal Cycler  

 
2.2.2 Pipettes - 2 µL, 10 µL, 20 µL, 100 µL and/or 200 µL 

 
2.2.3 8- Channel Pipette – Range 0.5 µL to 10 µL 

 
2.2.4 Repeat pipetter – Range 1.0 µL to 1.25 mL 

 
2.2.5 Biological Safety Hood 

 
2.2.6 Microcentrifuge tube racks 

 
2.3 Materials 

 
2.3.1 Sterile ART pipette tips - 2 µL, 10 µL, 20 µL, 100 µL and/or 200 µL 

 
2.3.2 1.5 mL microcentfuge tubes 

 
2.3.3 Kimwipes 

 
2.3.4 Sterile MicroAmp® tubes (0.2 mL tubes)  

 
2.3.5 Gloves 

 
2.3.6 96 well amplification plates (TempPleat(R) III P/N 1402-9700 or similar) and strip caps or plate sealing 

film (TempPlate® P/N 2921-000 or similar) 
 
2.4 Reagents 
 

2.4.1 Powerplex® 16 System Primer Pairs 
 

2.4.2 Sterile Type I Water 
 

2.4.3 Gold ST*R 10X Buffer 
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2 PCR Amplification 
 

2.4.4 Control DNA (2800M positive amplification control) 
 

2.4.5 AmpliTaqTM Gold DNA Polymerase 
 
2.5 PowerPlex® 16 System Amplification Procedure for the 9700 Thermal Cycler 
 

NOTE: A dedicated area, such as a biological hood or a separate room, should be used for preparing PCR 
amplification reactions. All equipment and supplies used to prepare amplification reactions should be 
kept in this dedicated "clean" area at all times. Do not use these items to handle amplified DNA or other 
potential sources of contaminating DNA. Trace amounts of amplified DNA, if carried over into other 
samples before amplification, can lead to results that can be misinterpreted. DO NOT bring amplified 
DNA, or equipment and supplies used to handle amplified DNA, into the designated "clean" area. Wear 
clean disposable laboratory gloves while preparing samples for PCR amplification. Change gloves 
frequently or whenever there is a chance they have been contaminated with DNA. 
 

2.5.1 Amplification Parameters for the 9700 Thermal Cyclers: 
 
2.5.1.1 Turn on the 9700 thermal cycler. Program as follows using the step cycle file, change the 

default setting to: 
 

Set a hold file for 11 minutes at 950C. 
Link this hold file to a separate hold file to denature at 96°C for 1 minute.  
Link this preheat program to a separate program as follows: 
Ramp 100% to denature at 94°C for 30 seconds 
Ramp 29% to anneal at 60°C for 30 seconds   
Ramp 23% to extend at 70°C for 45 seconds 
 
Program for 10 cycles 
Link this program to a separate program as follows: 
Ramp 100% to denature at 90°C for 30 seconds 
Ramp 29% to anneal at 60°C for 30 seconds  
Ramp 23% to extend at 70°C for 45 seconds 
 
Program for 21 cycles 
Link to a 60°C hold file for 30 minutes     
Link to a 4°C hold cycle. This program may be saved as a “User File” for later use. 

 
NOTE: The PowerPlex® 16 Allelic Ladder and Internal Lane Standard 600 supplied in the 

PowerPlex® 16 System kit do not require amplification and should not be stored in 
the sample preparation area. 

 
2.5.2 Transfer the PowerPlex® 16 System amplification reagents to the designated "clean" area and allow the 

Gold ST*R 10X Buffer, positive amplification control and the PowerPlex® 16 10X Primer Pairs to thaw 
completely at room temperature. 

 
2.5.3 Label a 96-well plate or place the required number of labeled sterile MicroAmp® reaction tubes in a rack. 

 
2.5.4 Calculate the required volume of each PCR amplification component to prepare a master mix by 

multiplying the volume by the number of samples. This should include reagent blanks, a random sample, 
and positive and negative amplification controls and additional reaction volumes (depending on the 
number of samples being amplified) to compensate for any pipetting variation. The PCR Master Mix 
should be prepared in a clean 1.5 mL microcentrifuge tube. 

 
Half Reaction Master Mix: 

 
1.25 µL Gold ST*R 10X Buffer 
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2 PCR Amplification 
 

1.25 µL PowerPlex® 16 10X Primer Pairs 
4.60 µL Sterile Type I Water 
0.40 µL AmpliTaqTM Gold Enzyme (2 Units) 

 
2.5.5 Add 7.5 µL of PCR Master Mix to each labeled sterile MicroAmp® tube or well of the 96 well plate using 

sterile ART tips or repeat pipetter.  
 

NOTE: Each PowerPlex® 16 System amplification is performed in a final volume of 12.5 µL. Exactly 5 
µL has been allocated for the sample DNA.  

 
NOTE: If using a plate format, once the mastermix is distributed, each column of the amplification plate 

should be covered with a strip cap. Only one column should be opened at a time during DNA 
sample transfer on both the extracted DNA plate as well as the amplification plate. 

 
2.5.6 Prepare the sample DNA and controls as follows: 

 
2.5.6.1 Dried blood stains/buccal cells/random sample: Add 1.0 µL or what has been determined 

to be the optimal volume of extracted DNA to the appropriate labeled sample tube or well. 
Bring the total volume up to 5 µL by adding sterile Type 1 Water to the tube or well. 
 
NOTE: weaker/difficult samples may require a higher volume to obtain a complete DNA 

profile. 
 

2.5.6.2 Positive Amplification Control: Gently mix by hand the Control DNA positive amplification 
control) followed by a light tapping of the tube on the counter top to remove any liquid from 
the cap. Carefully add 5 µL of DNA (0.62 to 1.25 ng/5 µL) of the Control DNA to the 
appropriate labeled sample tube or well.  

 
NOTE: When preparing the stock Control DNA (positive amplification control), dilute the 

sample to a concentration of 0.125 to 0.25 ng/µL with sterile Type I Water. 
 

2.5.6.3 Negative Amplification Control: Open the MicroAmp® tube and carefully add 5 µL of sterile 
Type I water to the appropriate labeled sample tube or well. 
 

2.5.6.4 Reagent Blank: Open the MicroAmp® tube or well and carefully add 5 µL of the reagent 
blank to the appropriate labeled sample tube or well.  
 

2.5.7 Place the 96 well amplification plate or MicroAmp® tubes into the thermal cycler. Push the plate or tubes 
down completely into the block. Place the thermal cycler lid over the samples and tighten. 

 
2.5.8 When the thermal cycler prompts the user for the sample volume, choose 13 µL.  
 
2.5.9 Start the amplification file and verify the cycling parameters by monitoring the first cycle.  
 

 NOTE:  The PCR amplification program will run for approximately 3 hours.  
 

2.5.10 After the amplification process is complete, remove the 96 well amplification plate or tubes from the 
thermal cycler and proceed with all samples to Section 3, Capillary Electrophoresis.  

 
2.5.11 Amplified DNA samples should be stored in the dark at 2 to 8 °C for a few days or at -20 °C for extended 

periods in a post-amp area.
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3 Capillary Electrophoresis 
 

3 CAPILLARY ELECTROPHORESIS 
 
3.1 Technical Notes 
 

3.1.1 The Applied Biosystems 3130xl Genetic Analyzer is a fluorescent capillary electrophoresis (CE) 
instrument with a 16 capillary array which can be used for DNA sequencing and fragment analysis 
applications. This includes STR (Short Tandem Repeat) analysis as well as DNA sequencing and SNP 
(Single Nucleotide Polymorphism) analysis. 

 
3.1.2 The capillary length and polymer type will vary based on the individual application. Sample handling and 

injection is automated by use of the autosampler, which holds two 96 or 384 well plates. 
 
3.1.3 The polymer delivery pump (PDP) automates the replenishment of polymer between injections so that the 

instrument is capable of fully-automated operation. 
 
3.1.4  Fluorescent detection is accomplished by utilizing an argon-ion multi-line, single mode laser with 

primary excitation lines at 488 ηm and 514.5 ηm to excite fluorescent dyes and a CCD camera records the 
fluorescence emitted from samples within each of the 16 capillaries. 

 
3.1.5 Data analysis including color separation is performed semi-automatically through the use of 

GeneMapper® ID software v3.2.1. 
 
3.1.6 For the purpose of this manual, the following definitions apply: 
 

3.1.6.1 Injection - all samples that were separated via CE at a single time. Thus, for one injection on 
the 3130xl, up to 16 samples can be separated at a single time. 

 
3.1.6.2 Run - all samples that were defined on a single plate and loaded onto the instrument at a 

single time for separation, regardless of the number of injections utilized to separate each 
sample contained on the plate. Thus, a run could contain up to 96 samples for separation on a 
single plate. 

  
3.2 Equipment 

 
3.2.1 Applied Biosystems 3130xl Genetic Analyzer 

 
3.2.2 Heat block, capable of 95 oC 

 
3.2.3 Pipettes 2µl, 10µl, 20µl, 100µl and/or 200µl 

 
3.2.4 Channel Pipette Range 5µl to 10µl 

 
3.3 Materials 

 
3.3.1 36-cm capillary array (Applied Biosystems, Inc. P/N 4315931 (16-capillary)) 

 
3.3.2 MicroAmp® Optical 96-Well Reaction Plate (Applied Biosystems, Inc. P/N N801-0560)  

or 96-well half-skirt plate (Greiner Bio-One, P/N 652260) 
 

3.3.3 96-well plate septum (Applied Biosystems, Inc. P/N 4315933) 
 

3.3.4 96-well plate retainer and base (Applied Biosystems, Inc. P/N 403081 and N801-0531) 
 

3.3.5 50 mL conical tube 
 

3.3.6 Freezer block 
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3 Capillary Electrophoresis 
 

3.3.7 Sterile ART tips for pipettes – 10µL, 20µL, 100µL, 200µL, and 1000 µL  
 

3.4 Reagents 
 
3.4.1 PowerPlex® Matrix Standard 3100/3130 (Promega Corp. P/N DG4650) 

 
3.4.2 10x Genetic Analyzer Buffer with EDTA (Applied Biosystems, Inc. P/N 402824) 

 
3.4.3 Hi-Di Formamide (Applied Biosystems, Inc. P/N 4311320) 

 
3.4.4 PowerPlex® 16 Allelic Ladder (Promega Corp. P/N DG600B) 

 
3.4.5 Internal Lane Standard (ILS) 600 Size Standard (Promega Corp. P/N DG261A) 

 
3.4.6 POP-4 Polymer (Applied Biosystems, Inc. P/N 4363752 (3.5 mL) or P/N 4352755 (7 mL)) 

 
3.5 Safety Considerations 

 
3.5.1 The Applied Biosystems 3130/3130xl Genetic Analyzer uses an Argon-ion laser. Under normal operating 

conditions, the instrument laser is categorized as a Class I laser. All instrument panels must be in place on 
the instrument while the instrument is operating. When all panels are installed, there is no detectable 
radiation present. If any panel is removed when the laser is operating, (during service with safety 
interlocks disabled) you may be exposed to laser emissions in excess of the Class 3B rating. Do not 
remove safety labels or disable safety interlocks. 
 

3.5.2 Performance Optimized Polymer (POP) is an irritant, always wear gloves when handling or cleaning 
liquid or dried polymer. It may cause skin, eye, and respiratory tract irritation. 
 

3.5.3 Exposure to Hi-Di Formamide causes eye, skin, and respiratory tract irritation. It is a possible 
developmental and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves. 
 

3.6 Computer 
 
3.6.1 Turn on the power for the computer.  

 
3.6.2 Turn on the power for the 3130xl instrument. Wait for the solid green light on the front of the instrument. 

 
3.6.3 Select the Data Collection icon from the screen to start the Data Collection software. The service console 

opens, as shown in Figure 1. When all of the applications are running, the Data Collection Viewer 
window opens and green squares appear, as shown in Figure 1.  
 

 
 

Figure 1. Data Collection service console. 
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3 Capillary Electrophoresis 
 

3.7 Sample and Instrument Preparation 
 
3.7.1 Install the Capillary Array 

 
3.7.1.1 If a capillary array has already been installed on the instrument, proceed to section 3.7.2 for 

continued preparation of the instrument. 
 

3.7.1.2 In the Data Collection software, select the “Wizards” menu and choose “Install Array”. 
Follow the on-screen directions for installing a capillary array. 
 

3.7.1.3 If a new capillary array has been installed on the instrument, a spatial and spectral calibration 
must be completed prior to running samples on the instrument. Refer to Appendix C for 
detailed instructions on running the calibrations. 
 

3.7.2 Set the oven temperature to 60 oC.  
 
3.7.2.1 In the Data Collection software, select Manual Control in the tree pane to bring up the manual 

control dialog box, as shown in Figure 2. 
 

 
 

Figure 2. Manual Control dialog box. 
 

3.7.2.2 Select “Oven” in the drop down menu for “Send Defined Command For:” 
 

3.7.2.3 Select “Set oven temperature” from the drop down menu under “Command Name”. 
 

3.7.2.4 Type 60 for the value and click “Send Command”.  
 
3.7.2.4.1 Note: the instrument default oven temperature is set at 50 oC. Therefore, the 

temperature must always be set to 60 oC for the pre-warming, prior to turning 
the oven on. 
 

3.7.3 Turn on the oven. The oven should be warming up as samples are being prepared, or approximately 30-
45 minutes. 
 
3.7.3.1 Select “Turn On/Off oven” under command name and “On” from the drop down list under 

Value.  
 

3.7.3.2 Click “Send Command”. 
 

3.7.4 Preparation of the convicted offender/arrestee sample plate 
 
3.7.4.1 Prepare a ‘master mix’ of formamide and size standard as follows: 
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3 Capillary Electrophoresis 
 

3.7.4.1.1 Thaw the Hi-Di formamide to room temperature, vortex to mix, and pipet 
9.5 µL of Hi-Di formamide for each sample (as well as extra samples to account 
for pipetting variation which will vary depending on the number of samples) to a 
clean microcentrifuge tube. If preparing an entire plate of samples (96), 
preparation of the master mix for approximately 106 samples is appropriate. 
 

3.7.4.1.2 Vortex the ILS 600 Size Standard (stored at -20 oC) and pipet 0.5 µL per sample 
(as well as the same number of extra samples as in 3.7. 4.1.1) to the 
microcentrifuge tube containing the formamide. 
 

3.7.4.1.3 Vortex this ‘master mix’ to ensure the contents are thoroughly mixed.  
 

3.7.4.2 Pipet 10 µL of the ‘master mix’ into each used well of the 96-well plate.  
 

3.7.4.3 10 µL of Hi-Di formamide or extra ‘master mix’ should be pipetted into unused wells of the 
plate that will be injected to ensure that air is not injected into some of the capillaries. (That 
is, if one injection (16 samples total) will be completed on the 16-capillary 3130xl, it is 
necessary to ensure that all sample wells in the two columns contain liquid.) 
 

3.7.4.4 Place the plate septum on top of the sample wells and use a scalpel to cut the septum into 
single column strips. During the amplified DNA transfer, only one column of both the CE 
plate as well as the amplification plate should be open at a time. Pipet PCR product (for 
samples, positive controls, and negative controls) into the corresponding well of the 96-well 
plate. Typically, 1 µL of PCR product will be added. However, 0.5 µL or 2 µL of the PCR 
product may be used at the analyst’s discretion and will be noted on the technical 
documentation. 
 
NOTE: The same volume of PCR product (or more) used for the samples must also be used 

for the negative controls and reagent blanks.  
 

3.7.4.5 Pipet 1 µL of allelic ladder into at least two wells per plate. 
 

3.7.4.6 After addition of all samples, the plate will be heated at 95 oC for ≥3 minutes. 
 

3.7.4.7 Following heating, the plate should be placed in a freezer block or on ice for at least three 
minutes prior to loading. After heating, ensure that no bubbles are present at the bottom of the 
wells in the plate. Tapping the plate on the lab bench typically removes any such bubbles, if 
present. Alternatively, the plate may be pulse-spun in a centrifuge equipped with a plate rotor.  
 

3.7.5 Complete the following maintenance tasks: 
 
3.7.5.1 Prepare 35 mL of 1X Genetic Analysis Buffer with EDTA by diluting the 10X stock Genetic 

Analysis Buffer with EDTA. The 1X Genetic Analysis Buffer may be used for up to 48 hours 
after its preparation. Ensure adequate levels of buffer are in the respective reservoirs 
(reservoir 1, as shown in Figure 3, and the anode buffer reservoir, as shown in Figure 5) and 
the outside of the reservoirs are dry. Remove any buffer droplets from the inside of the 
reservoirs that may be clinging to the walls. 
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3 Capillary Electrophoresis 
 

3.7.5.2 When replacing the 1X running buffer, the water reservoirs should also be rinsed and refilled 
with Type 1 H2O to the fill line. Figure 3 shows a diagram of the reservoirs, indicating which 
contain H2O and buffer. 
 

 
 

Figure 3. Location of buffer and water reservoirs on the 3130xl. 
 

Figure reproduced from Applied Biosystems 3130/3130xl Genetic Analyzers (2004) 
Maintenance and Troubleshooting Guide 

 
3.7.5.3 Ensure the plate assemblies are properly assembled (as shown in Figure 4) and positioned on 

the deck properly. Note: if the plate assembly is properly assembled, the gray septa will not be 
visible when looking down through the holes of the plate retainer. Instead, the wells will 
appear black. If the plate assembly is not properly assembled, damage to the capillary array is 
likely to occur.  
 

 
 

Figure 4. Proper assembly of the plate for loading onto the instrument. 
 

Figure reproduced from Applied Biosystems 3130/3130xl Genetic Analyzers (2004) 
Maintenance and Troubleshooting Guide 

 
3.7.5.4 Check for bubbles in the pump block, lower polymer block, interconnect tube, polymer 

supply tube, and channels. If bubbles are present, remove all bubbles with the Bubble Remove 
wizard.  
 

3.7.5.5 Check the loading-end header to ensure the capillary tips are not crushed or damaged.  
 

3.7.5.6 Ensure that sufficient volume of polymer is present in the bottle for run. (Note: approximately 
0.5 mL of polymer is sufficient to run approximately a plate of samples without introduction 
of bubbles into the pump block. Additional polymer may be necessary to clear bubbles, etc.) 
 

3.7.5.7 Ensure that the pump block and lower polymer block are securely fit on the instrument. 
 

3.7.5.8 Ensure that the instrument surfaces are clean; always use deionized water to clean. 
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3 Capillary Electrophoresis 
 

3.7.5.9 Check for leaks around the array knob, interconnecting tube nuts, and check valve, all of 
which are shown in Figure 5.  

 
 

Figure 5. Diagram of the pump block and associated components of the ABI 3130xl Genetic Analyzer. 
 

Figure reproduced from Applied Biosystems 3130/3130xl Genetic Analyzers (2004) Maintenance and Troubleshooting Guide 
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3 Capillary Electrophoresis 
 

3.8 Instrument Operation 
 
3.8.1 Ensure that the instrument doors are closed and the green light on the front panel of the instrument is on. 

Open the 3130xl data collection software. The data collection software sets up the instrument for 
operation and data collection and manages the database for every aspect of the capillary electrophoresis. 
The software has two basic components: Data Management and Instrument Control, both of which are 
found in the tree pane shown in Figure 6. 
 

 
 

Figure 6. Tree pane of the Data Collection software on the computer 
associated with the 3130xl Genetic Analyzer. 

 
3.8.2 Plate Manager – Sample information is entered into corresponding plate locations along with the 

individual protocol, results group, and analysis method for each sample loaded on the plate. Sample 
information can be entered manually within the plate manager or imported from an external worksheet. 
Each injection group (16 samples corresponding to the 16 capillaries) must have the same instrument 
protocol as it represents a single injection. Samples should be organized on the plate in order to maximize 
efficiency considering the capillaries labeled 1-16 correspond to A1-H2, A3-H4, A5-H6, A7-H8, A9-
H10, and A11-H12 on the sample plate for each injection. See Figure 7. 

 

 
 

Figure 7. Schematic of capillary locations (left) and depiction of sample plate (right). 
Capillaries labeled 1-16 correspond to A1-H2, A3-H4, A5-H6, A7-H8, A9-H10, and A11-H12 

on the sample plate for each injection, resulting in a maximum of six injections per 96 sample plate. 
 

Figure reproduced from Applied Biosystems 3130/3130xl Genetic Analyzers (2004) 
Maintenance and Troubleshooting Guide 

 
3.8.2.1 Click on the Plate Manager from the ga3130xl dropdown list. 

 
3.8.2.2 The sample information may be entered in a manual or automated fashion. 

 
3.8.2.3 Manual Sample Information Input. 
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3 Capillary Electrophoresis 
 

3.8.2.3.1 Click the “New” button at the bottom of the display to open the New Plate 
Dialog box. 
 

3.8.2.3.2 Complete the information in the New Plate Dialog: Type a name and description 
(optional) for the plate.  
 

3.8.2.3.3 Select your fragment analysis application in the “Application” drop-down list. 
Typically, this will be “3130xl_1. 
 

3.8.2.3.4  Select 96-well or 384-well in the “Plate Type” drop-down list. 
 
3.8.2.3.4.1 Type DFS for the owner and a name or initials for the operator. 

 
3.8.2.3.4.2 Click “OK” to open the Plate Editor, as shown in Figure 8. 

 

 
 

Figure 8. Plate Editor. The sample name, results group, instrument protocol,, etc. 
are set for each sample being separated on the 3130xl. 

 
3.8.2.3.5 For each sample, fill in the following: 

 
• Sample Name 

  
• The Priority column will fill in automatically. Lowering the number (100 is 

default) for each set of 16 samples increases the priority. 
 

• Comments column, enter any comments or notations for the sample 
(optional) 
 

• Sample Type – choose either allelic ladder, positive control, negative 
control, or unknown from the drop down list. 
 

• Size Standard – choose ILS600 from the drop down menu 
 

• Panel – choose the PowerPlex® 16 panel from the options listed. Typically, 
this will be “PowerPlex_16_ID3.2.0”. 
 

• Analysis Method – choose the appropriate analysis method. Typically, this 
will be “PowerPlex16advanced”, found under a sub-menu.  
 

• Results Group - select a group from the drop-down list or create a new one 
(as described above). 
 

• Instrument Protocol – select a protocol from the drop-down list. This will be 
“PP16_5sec” for the PowerPlex® 16 kit unless otherwise indicated.  

 
3.8.2.3.5.1 When finished entering the information in the plate manager, 

click “OK”. 
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3 Capillary Electrophoresis 
 

3.8.2.3.5.2 NOTE: The same injection time or longer than that used for the 
samples must be used for the negative controls and reagent 
blanks.  

 
3.8.2.3.6 Automated Sample Input 

 
3.8.2.3.6.1 The plate data must be created from an outside program such as 

Microsoft Excel and be in a tab-delimited, txt, format before it 
can be imported. 

 
3.8.2.3.6.2 In the plate manager, Click on the “Import” button on the bottom 

of the display to open the “Import Plate” dialog box, as shown in 
Figure 9. 

 

 
 

Figure 9. Plate Manager window. To import sample information from 
an Excel spreadsheet, click “Import…” near the bottom of the screen 

(as indicated by the arrow). 
 
3.8.2.3.6.3 Select the location and file containing the plate data and click on 

“OK”. The plate will be added to the list of plate records. 
 

3.8.2.3.6.4 Check the plate record by selecting the plate and clicking “Edit” 
to ensure the plate samples, results groups, protocols, and 
analysis methods are correct. 

 
3.8.2.3.6.5 NOTE: The same injection time or longer than that used for the 

samples must be used for the negative controls and reagent 
blanks.  

 
3.8.3 Run Scheduler – Two plates may be loaded onto the autosampler at a time in positions A or B. The run 

scheduler designates which plates are located in which position on the autosampler. When loading the 
autosampler, ensure the plate is properly positioned in either position A or B. The plate on the left in the 
autosampler is defined as position A and the plate on the right is defined as position B, as described 
below. If two plates are loaded into the autosampler, the plate which is linked to its platemap first will be 
the first plate injected, regardless of whether it is in position A or B. 
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3 Capillary Electrophoresis 
 

3.8.3.1 Click “Run Scheduler” in the tree pane of the Data Collection software to open the Run 
Scheduler window, as shown in Figure 10.  
 

 
 

Figure 10. Run Scheduler window. To start a run, click “Find All” in the Run scheduler 
to find the name of the plate you wish to run. 

 
3.8.3.1.1 Click on the plate name to highlight the entire row. 

 
3.8.3.1.2 Click the location of that plate in the instrument (position A or B, to the left or 

right, respectively). The color of the grid will change color from yellow to green 
to indicate the linking of the plate name to the location. 
 

3.8.3.1.3 Repeat 3.8.6.1.1 and 3.8.6.1.2 to indicate the location of a second 96-well plate, 
if necessary. 

 
3.8.3.2 Once the plates have been linked, the run can be started. Click the green button           in the 

toolbar. 
 

3.8.3.3 The Processing Plates dialog box opens, then click “OK”.  
 

3.8.3.4 Following completion of the run, proceed to Chapter 4 for data analysis.
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4 Analysis of Capillary Electrophoretic Data 
 

4 ANALYSIS OF CAPILLARY ELECTROPHORETIC DATA 
 
4.1 Technical Notes 

 
4.1.1 The raw data obtained with the Applied Biosystems 3130xl Genetic Analyzer can be analyzed using 

GeneMapper® ID software v3.2.1. 
 

4.1.2 GeneMapper® ID is an automated genotyping software program for forensic data analysis that supports 
analysis of electropherogram data obtained from the ABI 310 Genetic Analyzer, ABI 377 DNA 
Sequencer, ABI 3100 and 3100-Avant Genetic Analyzers, and the ABI 3130 and 3130xl Genetic 
Analyzers.  
 

4.2 Logging On 
 
4.2.1 Open the GeneMapper® ID software v3.2.1 by double-clicking on the software icon. 

 
4.2.2 Select the appropriate user name and type the password. 

 
4.2.3 Click OK. 

 
4.3 Pryoject Window 

 
4.3.1 Upon opening the GeneMapper® ID software, the user is taken to the Project Window, as shown in Figure 

1. 
 

 
 

Figure 1. Project Window. 
 

4.3.2 To begin the data analysis, samples must be added to the project to be analyzed. 
 
NOTE: All samples to be analyzed from a single run should be added at once. If not done in this 

manner, the GeneMapper® ID software may not associate the correct allelic ladders with the 
given samples.  

 
4.3.2.1 Choose “File” and “Add samples to Project” or, click the icon. 

 
4.3.2.2 Browse to the data files to analyze. You may select the entire folder or pick the files within 

the folder to analyze. 
 

4.3.2.3 Click “Add to List” (bottom left of screen) then “Add” (bottom right of screen).  
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4 Analysis of Capillary Electrophoretic Data 
 

4.3.3 Upon addition of the samples to the project, the “Samples” tab will become populated, as shown in Figure 
2. The population of the information is based on that entered in the Plate Map in the ABI 3130xl Data 
Collection Software. Double check to ensure that the correct panel, sample type, and analysis method are 
selected. If changes need to be made to this information, select the necessary cells and choose the 
appropriate settings from the drop-down menus. Verify that the information is correct before proceeding.  
 

 
 

Figure 2. “Samples” tab upon adding samples to the newly created project. 
 

4.3.3.1 Anaysis Method = “PowerPlex16advanced”. 
 

4.3.3.2 Panel = “PowerPlex_16_ID3.2.0”. 
 

4.3.4 Each data file has an            icon in the Status column indicating that it needs to be analyzed. 
 

4.3.5 In the tree pane view on the left side of the screen, choose the file name of a negative control. Choose 
View>Raw Data to view the unseparated raw fluorescence data.  
 

4.3.6 The recognizable pattern of the size standard should appear in red. The raw data may be used to evaluate 
baseline problems or noise that could result in poor sizing. In addition, the start and stop points for the 
analysis should be noted. The start and stop points should be such that all size standards are encompassed 
by the data points analyzed. Typically, this is approximately 3000 – 10000 data points, but may need to 
be modified on a per-run basis, if, for example, at the 10,000 end point, the 600 bp size standard is 
missing. Extending the range beyond 10,000 will include the missing 600 bp fragment. This start and stop 
point may be edited in the Analysis Method Editor, as shown in Appendix E. 
 

4.3.7 Exit from the Negative Control raw data, and select Analysis>Analysis Method Editor  
 
4.3.7.1 Click on the “Peak Detector” tab. 
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4 Analysis of Capillary Electrophoretic Data 
 

4.3.7.1.1 The Peak Detector tab is where the values such as dye specific detection 
thresholds and analysis start and stop points are set (Figure 3).  
 

 
 

Figure 3. The Peak Detector Tab window. A solid arrow indicates the data analysis range start and stop points. 
The dashed arrow indicates the peak amplitude threshold for the red dye, which may be altered if needed. 

No other threshold values may be altered. 
 

4.3.7.1.2 Change the analysis range to the start and stop points defined in 4.3.6, if 
necessary.  
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4 Analysis of Capillary Electrophoretic Data 
 

4.3.7.1.3 The values for the peak amplitude thresholds are based upon empirical data 
derived from the limit of detection analysis performed during the validation 
work and specific for each 3130xl instrument. While the ILS 600 (which uses 
the red dye) will have its default peak amplitude threshold set based on the LOD 
analysis, the threshold may be adusted upward which is high enough to prevent 
detection of a known artifact present in the Promega ILS 600 size standard 
(Figure 4) or reduced when the ILS 600 peaks may fall below the default 
threshold (this can occasionally occur with the 2 second injection). It is 
important to note that ONLY the Red dye (ILS 600 size standard) may be 
adjusted if such conditions are present. If such adjustment is necessary, refer to 
Appendix E for directions. 
 

 
 
Figure 4. Size Match Editor window showing the ILS 600 size standard. 

The arrow points to the artifact at approximately 172 bp. 
 

4.3.7.1.4 Click OK.  
 

4.3.8 Analyze the samples by clicking the green arrow:            (Analyze). Upon prompting, type a name for the 
project. Click OK. 
 

4.3.9 Examining Analysis Results 
 
4.3.9.1 Assess the run by first examining the flags in the SQ (sizing quality) column. A green square 

indicates that a sample has passed the sizing criteria. For any samples that do not pass the 
sizing criteria, indicated by a yellow triangle or red octagon, assess the size standard by 
highlighting the samples and click on the icon:             or selecting Analysis>Size Match 
Editor. 
 
NOTE: If the majority of the size standards fail, look for a global problem with the run, such 

as a poorly-chosen sizing range in the Analysis Method Editor (see Appendix E). 
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4 Analysis of Capillary Electrophoretic Data 
 

4.3.9.2 If the sizing standard is observed in the sample, check to see that all peaks are detected and 
the peaks are labeled correctly. The peaks should follow the pattern shown in Figure 8. Spikes 
or other artifacts may be mislabeled by the software, resulting in poor sizing.  

 
 
 
 

 
 
 

 
Figure 5. ILS 600 Size standard. The peaks are labeled with their base pair size. The 60 bp and 80 bp 

peaks are unlabeled in this figure and may or may not be utilized for sizing purposes. 
 

4.3.9.2.1 If the size standard peak assignments are incorrect for one or more of the 
samples, adjust the peak assignments within the size match editor.  
 
4.3.9.2.1.1 The sizing quality of the sample is shown directly above the 

labeled size match electropherogram, as shown in Figure 8. 
Typically, a low sizing quality value (e.g., 0.5) is a result of a 
peak shift (the software incorrectly identifies one peak resulting 
in invalid positions for the other size standard peaks), a missing 
peak (the software does not identify a peak), or an extra peak 
(the software identifies a peak that is not a size standard peak, 
but a spike or pull-up peak).  

 
4.3.9.2.1.2 To edit a particular size standard peak, right-click the peak to be 

edited to open the editing pop-up window and select “Add”, 
“Delete” or “Change” the selected peak. Move the cursor to the 
right to open the Select Size sub-menu. Choose the desired size 
from the menu. 

 
Note: The 225 bp size standard may be deleted without 

compromising the sizing accuracy (source: Promega 
Corp). This may be occasionally necessary since pull-up 
from the yellow (TMR) channel can produce a pull-up 
peak which overlaps with the 225 bp fragment and results 
in inaccurate sizing and allele calls. 
 

4.3.9.2.2 When the peaks are sized properly, check the sizing quality by selecting 
Tools>Check Sizing Quality. If the peaks are sized correctly, the quality value 
will improve. If the peaks are sized correctly but the quality score is still below 
passing, click the “Override SQ” button, as shown in Figure 5, to set the sizing 
quality to 1.0. Note that the sizing quality will now read <1.0> and         will 
appear in the Sample tab under the SQO (Sizing Quality Override) column to 
indicate the sizing quality has been overridden by the analyst. If the 225 bp 
standard is deleted due to pull-up as described above, the       will also appear if 
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4 Analysis of Capillary Electrophoretic Data 
 

the sizing quality is improved, even if the “Override SQ” button is not clicked, 
indicating that the size standard was edited. The same icon will also appear in 
the electropherogram printout in the header for each dye. Alternatively, the 
sample may be re-injected at the analyst’s discretion.  
 
4.3.9.2.2.1 Review of the Allelic Ladder Data 

 
4.3.9.2.2.1.1 In the “Samples” tab, select each allelic ladder.  

 
4.3.9.2.2.1.2 Display the plots by clicking the sample plots 

icon: 
 

4.3.9.2.2.1.3 Verify that the allelic ladder is called correctly 
for each locus. Figure 6 represents an example 
of an accurately designated PowerPlex® 16 
allelic ladder. Note that the yellow dye appears 
in black in all electropherograms for easier 
viewing. 

 

 
 

Figure 6. PowerPlex® 16 Allelic Ladder. 
 

4.3.9.2.2.2 Review of sample data 
 

4.3.9.2.2.2.1 All sample data must be reviewed carefully, 
with special attention paid to samples that 
display a yellow triangle or red octagon, 
indicating low quality analysis.  

 
4.3.9.2.2.2.2 A green square indicates that the data passed 

the initial (automated) analysis by the software 
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in the respective category (such as sizing 
quality, off-scale data, etc.).  

 
4.3.9.2.2.2.3 If a flag is yellow or red, it may be helpful to 

look at the raw data to determine the problem. 
To look at the raw data from the samples tab, 
highlight the sample and select View>Raw 
Data. 

 
4.3.9.2.2.2.4 If it is determined that the sample should not 

be considered for interpretation due to 
problems within the raw data, the sample may 
be re-injected or run again using a different 
amplification reaction, more PCR product, less 
PCR product, or other necessary procedures. 

 
4.3.9.2.3 If the sizing quality for a given sample is low, the sample will not be genotyped 

by the software.  
 

4.3.9.2.4 The sample data can be viewed by selecting View>Sample Plot or choosing the 
icon:          The data is displayed as shown in Figure 7. 

 

 
 

Figure 7. An example of PowerPlex® 16 sample data. Under each allele, the allele call (repeat number), 
height (RFUs), and size (bp) are listed. If an edit was made to the allele call, 

this comment would also be indicated in the box under the peak. 
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4 Analysis of Capillary Electrophoretic Data 
 

4.3.9.2.5 The negative control(s) should be checked to ensure that no amplification 
product (called alleles) was observed. A called allele is a peak which fits the 
criteria to be designated an allele or OL (off ladder) and is above the allele 
calling threshold designated in the software and therefore is labeled. Refer to 
Chapter 5 for the interpretation guidelines. 
 

4.3.9.2.6 The positive control(s) should be checked to ensure that injection and 
electrophoresis performance was satisfactory. Refer to Chapter 5 of for the 
interpretation guidelines. 
 
4.3.9.2.6.1 If the positive control was injected poorly, it can be re-injected 

or if necessary, the positive control sample can be re-prepared 
and injected. The original sample injections can be analyzed if 
the correct types for the positive control are documented upon 
the re-injection or re-run. However, in order to use the data 
produced in a run, at least one positive control on the run must 
result in the properly-designated alleles. 

 
4.3.9.2.6.2 Artifacts such as pull-up and spikes may occasionally occur and 

must be documented as described in Chapter 5 of this manual.  
 

4.3.9.2.6.3 If pull-up peaks are due to poor color separation and not 
excessive peak height of peaks in other channels, then a new 
spectral may need to be performed and the samples re-injected 
using the new spectral. 

 
4.3.9.2.7 The Genotypes tab of the project window displays a number of additional 

“flags” to indicate the quality of the data. These may be used, at the analyst’s 
discretion, to aid in interpretation of the data. Table 1 gives the name and 
description of the flags and their columns. 
 

4.3.9.2.8 The flags are check marks, green squares, yellow triangles, or red octagons. 
 
4.3.9.2.8.1 A check mark or green square indicates the data passes the 

analysis for that quality indicator. 
 

4.3.9.2.8.2 A yellow triangle indicates that the data should be reviewed. 
 

4.3.9.2.8.3 A red octagon indicates poor data quality or analysis quality. 
The sample may not be analyzed by GeneMapperTM ID in some 
instances.  

 
4.3.9.2.9 If the project file must be transferred to another, non-networked computer, the 

GeneMapperTM ID project must be exported.  
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4.3.9.2.9.1 Under the Tools drop-down window, select GeneMapper 
Manager and the following window will open up (Figure 8). 
 

 
 

Figure 8. GeneMapper Manager. 
 

4.3.9.2.9.2 Highlight the project file that is to be exported and select 
“export”. The project will be saved to the location and file folder 
designated. Transfer the project file to a CD or approved flash 
drive for transfer to another computer workstation.  
 

4.3.9.2.9.3 To open the profject file at another computer workstation, 
transfer the project file from the CD or flash drive to the desktop 
or a designated folder. Open GeneMapperTM ID and then open 
GeneMapper Manager as shown in Figure 8. Select import and 
your project file will be imported into the GeneMapperTM ID 
project file list. Select Open file in GeneMapperTM ID and find 
your project in the file list.  

 
Table 1. Peak Quality Value Flags on the Genotypes Tab 
 

Column Description 
AE Allele Edit 

♦ The check box is unchecked immediately after analysis. 
♦ The check box is checked when the marker allele calls have been edited by 

the analyst. 
ADO Allele Display Override 

♦ The checkbox is checked when the number of the marker calls exceeds the 
number to display previously set (in Table Settings Editor). 

SHP Sharp Peak 
♦ This flag is used for SNP analysis only, not fragment analysis. 

AN Allele Number 
♦ A flag is displayed when the number of alleles exceeds the maximum (or no 

alleles are found). This maximum is set in the analysis method. 
OBA One Basepair Allele 

♦ This flag is used for SNP analysis only, not fragment analysis. 
SPA Single Peak Artifact 

♦ This flag is used for SNP analysis only, not fragment analysis. 
Bin Out of Bin Allele 

♦ A flag is displayed when the called alleles’ peak apex is out of the bin 
boundary. The peak is then labeled “OL”.  
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PHR Peak Height Ratio 
♦ A flag is displayed when there are two alleles present and the ratio between 

the lower allele height and the higher allele height is below a certain level 
(default = 50%, set in the Peak Quality tab of the analysis method). The ratio 
is based on the peak height of the called allele peaks. 

LPH Low Peak Height 
♦ A flag is displayed when the alleles are lower than the specified values and do 

not result in the proper intensity. The default is 200 RFU, set in the Peak 
Quality tab of the analysis method. 

SPU Spectral Pull-Up 
♦ A flag is displayed when the marker signal contains bleed-through peaks 
♦ Pull-up is when the peak height of the called peak is less than 10% of the 

larger peak within ± 1 data point. 
BD Broad Peak 

♦ A flag is displayed when the called alleles’ peak width is wider than 1.5 
basepairs. 

SP Split Peak 
♦ A flag is displayed when a split peak is found by the software. 
♦ A split peak is defined as overlapping peaks that are < 0.25 basepairs apart. 

OS Offscale 
♦ A flag is displayed when there are offscale peaks present within the marker 

size range. 
CC Control Concordance 

♦ A flag is displayed when the designated control sample does not exactly 
match the defined alleles for this marker in the panel.  

OVL Overlap 
♦ A flag is displayed when a peak in the overlapped region is called twice, as it 

is possible to have two allele size ranges that overlap. 
NB Narrow Bin 

♦ This flag is used for SNP analysis only, not fragment analysis. 
DP Double Peak 

♦ This flag is used for SNP analysis only, not fragment analysis. 
GQ Genotype Quality 

♦ A red octagon is shown when the analysis for a sample is of low quality. 
♦ A green square indicates the analysis is of good quality. 
♦ A yellow triangle indicates the analysis should be checked. 
♦ The weighting of the various factors that are used for calculating the genotype 

quality are set by the analysis method. 
 

4.3.10 Printing the results 
 
4.3.10.1 If a printed copy of the elecropherogram is desired, after a review of each allele call in the 

samples plot, the x- and y-axes should be set accordingly for printing (as shown below). If the 
axis needs to be changed, right-click on the axis to display the scale settings. For printing 
purposes, the scale setting may be modified, if necessary, to allow visualization of specific 
characteristics of a particular electropherogram. 
 
4.3.10.1.1 X-axis = approximately 70bp – 500bp 

 
4.3.10.1.2 Negative Control or Reagent Blank: Y-axis = 0 – 100 RFU 

 
4.3.10.1.3 Samples, Positive Control, and Allelic Ladders: Y-axis = scaled to largest 

 peak 
 

4.3.10.2 Print the electropherogram by File>Print. 
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4.3.10.3 Should additional documentation be necessary to support an allele designation, other views of 
the data (such as a zoomed-in view of an electropherogram) may be printed, at the analyst’s 
discretion.
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5 Interpretation of Powerplex® 16 System PCR Amplification Results 
 

5 INTERPRETATION OF POWERPLEX® 16 SYSTEM PCR AMPLIFICATION RESULTS 
 
5.1 Technical Notes 

 
5.1.1 STR alleles are small in size, generally less than 500 bp and contain repeat units ranging from 3 to 7 

bases 
 

5.1.2 If an allele contains an incomplete repeat, the allele is considered a microvariant and is designated by the 
number of complete repeats present followed by a decimal point, followed by the number of bases of the 
incomplete repeat. For example, the FGA 22.2 allele contains 22 tetrameric repeats plus 2 bases. Because 
of a deletion of two bases the FGA 22.2 allele is two bases shorter than the FGA 23 allele. 
 

5.1.3 The characteristics of the PowerPlex 16 System and the allelic ladders are given in the table below1: 
 
Table 1. PowerPlex 16 System loci and allelic ladder alleles 
 

Locus * Repeat 
Sequence 

5' 3'  

Chromosome  
Location 

Size Range of 
Allelic Ladder 

(bp) 

Alleles present in 
Allelic Ladder 

Fluorescent  
Label 

FGA TTTC 
Complex 

4q31.3, αfibrinogen,  
3rd intron 

322-444 16-30, 31.2, 43.2, 
44.2, 45.2, 46.2 

TMR 

TPOX AATG 2p25.3 thyroid peroxidase,  
10th intron 

262-290 6-13 TMR 

D8S1179 TCTA 
Complex 

8q24.13 203-247 7-18 TMR 

vWA TCTA 
Complex 

12p13.31 von Willebrand 
Factor, 40th intron 

123-171 10-22 TMR 

Amelogenin NA Xp22.1-22.3 and Y 106 – X 
112 – Y 

X, Y TMR 

Penta E AAAGA 15q26.2 379-474 5-24 FL 

D18S51 AGAA 18q21.33 290-366 8-10, 10.2, 11-13, 
13.2, 14-27 

FL 

D21S11 TCTA 
Complex 

21q21.1 203-259 24, 24.2, 25, 25.2, 26-
28, 28.2, 29, 29.2, 30, 

30.2, 31, 31.2, 32, 
32.2, 33, 33.2, 34, 

34.2, 35, 35.2, 36-38 

FL 

TH01 AATG 11p15.5 tyrosine 
hydroxylase 1st intron 

156-195 4-9, 9.3, 10-11, 13.3 FL 

D3S1358 TCTA 
Complex 

3p21.31 115-147 12-20 FL 

Penta D AAAGA 21q22.3 376-449 2.2, 3.2, 5, 7-17 JOE 

CSF1PO AGAT 5q33.1 c-fms proto-
oncogene, 6th intron 

321-357 6 – 15 JOE 

D16S539 AGAT 16q24.1 264 – 304 5, 8 –15 JOE 

 
NOTE:  table continued below 
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Locus *Repeat 
Sequence 

5' 3' 

Chromosome 
Location 

Size Range 
of Allelic 

Ladder (bp) 

Alleles present in 
Allelic Ladder 

Fluorescent 
Label 

D7S820 AGAT 7q21.11 215 –247 6 – 14 JOE 

D13S317 AGAT 13q31.1 169 –201 7 – 15 JOE 

D5S818 AGAT 5q23.2 119 -155 7 – 16 JOE 

 
*All repeat sequences are defined using the recommendation of the DNA Commission of the International Society of 
Forensic Haemogenetics (ISFH): 1) for STR loci within coding genes, the coding strand shall be used and the repeat 
sequence motif defined using the first possible 5' nucleotide of the repeat motif; and 2) for STR loci not associated with a 
coding gene, the first database entry or original literature description shall be used.2,3 

 
KEY: TMR = carboxy-tetramethylrhodamine, 

FL = fluorescein, 
JOE = 6-carboxy-4’,5’- dichloro-2’,7’- dimethoxyfluorescein. 

 
5.1.4 Applied Biosystem 3130xl Genetic Analyzer1,2: 

 
 Fluorescein is detected at a wavelength of ~530-540 nm.  

 
 TMR is detected at a wavelength of ~580-590 nm. 

 
 JOE is detected at a wavelength of ~555 - 565 nm . 
 

5.1.5 The Fluorescent Internal Lane Standard 600 (CXR – carboxy-X-rhodamine) consists of 22 DNA 
fragments (60, 80,100, 120, 140, 160, 180, 200, 225, 250, 275, 300, 325, 350, 375, 400, 425, 450, 475, 
500, 550, and 600 bp) and can be detected at a wavelength ~615-625 nm1,2. 
 

5.1.6 The “Known” Genotypes for the Control DNA (positive amplification control) using the PowerPlex® 16 
System are given in the table below.1 

 
    Table 2. 2800M PowerPlex® 16 profile 
 

Locus Genotype  
Penta E 7, 14 

D18S51 16, 18 

D21S11 29, 31.2 

TH01 6, 9.3 

D3S1358 17, 18 

FGA 20, 23 

TPOX 11, 11 

D8S1179 14, 15 

VWA 16, 19 

Amelogenin X, Y 
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Penta D 12, 13 

CSF1PO 12, 12 

D16S539 9, 13 

D7S820 8, 11 

D13S317 9, 11 

D5S818 12, 12 

 
5.2 Procedure 

 
5.2.1 Verification of the allelic ladder 

 
Figure 1 shows electopherograms of the PowerPlex® 16 allelic ladder. Ensure that alleles in the allelic 
ladder are properly designated.  
 

 
 

Figure 1. PowerPlex® 16 allelic ladder 
 

5.2.2 The electropherogram data will be evaluated in order to determine if samples need to be re-injected, 
injected for a longer or shorter period of time, more/less amplified DNA added to the injection cocktail or 
if a new spectral must be created due to excessive pull-up. 
 
 
 
 
 
 
 
 

Data Bank PowerPlex® 16 Procedures Manual DFS Document 211-D400 
Issued by Biology Program Manager Revision 1 
Issue Date: 24-July-2014 Page 39 of 82 

 
COPYRIGHT © 2014 

VIRGINIA 
DEPARTMENT 

OF 
FORENSIC SCIENCE 

 
 
 

UNCONTROLLED 
COPY 



5 Interpretation of Powerplex® 16 System PCR Amplification Results 
 

5.2.3 The DNA sample from convicted offender or arrestee samples should be from a single person and appear 
as a single source profile. However, there are examples of three-allele patterns due to gene duplication or 
translocation events.3 Figure 2 shows an example of a single source profile. 

 
NOTE: Although average peaks height ratios for a heterozygous locus are most often above 0.6 when 

DNA quantity is above stochastic levels (250 pg and greater), minimum heterozygote 
balances have been observed below 0.6 for single source samples even at sufficient quantities 
of input DNA (250 pg and greater).4  

 

 
 

Figure 2. An electropherogram from a single source male sample. 
 

5.2.4 The GeneMapper® ID software provides information on peak quality (height, base pair size, shape, 
number) as well as designating alleles.  

 
5.2.5 When an excess of DNA is added to the amplification cocktail, artifacts may occur. Most of these 

artifacts will be below the 13% global filter cut-off or 20% stutter filter cut-off used for convicted 
offender and arrestee samples and will not be labeled by the software. Application of the global filter 
causes all peaks below 13% of the highest peak within each marker not to be labeled. Application of the 
20% stutter filter causes all peaks in (n-1) stutter position and below 20% of the main peak not to be 
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labeled. NOTE: If an analyst believes that a peak is real and the software does not label the peak due to 
the filters applied, the analyst may remove the filters and reanalyze the sample to better evaluate the peak 
in question. Excess DNA added to the PCR can produce an increased amount of PCR product and this 
can result in the following: 

 
5.2.5.1 Fluorescence intensity that exceeds the linear dynamic range for detection by the instrument 

("off-scale" data). Quantitation (peak height and area) for off-scale peaks is not accurate. For 
example, an allele peak that is off-scale can cause the corresponding stutter peak to appear 
higher in relative intensity, thus increasing the calculated percent stutter.  

 
5.2.5.2 Multicomponent analysis of off-scale data can result in poor spectral separation ("pull-up"). 

Refer to Figure 3 for an example of pull-up at the CSF1PO locus. 
 

 
 

Figure 3. Pull-up from the yellow/black channel (TMR) into the green channel (JOE), 
indicated by the red circle and shown as an edited off-ladder (OL) peak that has been changed 

to indicate pull-up (PU). Editing allele calls is described in 5.2.6. 
 

5.2.5.3 Incomplete +A nucleotide addition 
 

The PCR process using AmpliTaq Gold® is optimized such that an additional Adenosine 
nucleotide is added onto the extended fragment. Excessive input DNA makes the Adenosine 
addition less efficient and thus PCR fragments shorter by one nucleotide than the amplicon 
size may appear (-A). 

 
5.2.5.4 Stutter peaks 

 
Stutter peaks frequently appear during PowerPlex® 16 System profiling. These are most 
commonly 4 nucleotides smaller than the amplicon size (true peak) for the tetranucleotide 
repeats and 5 nucleotides smaller for the pentanucleotide repeats.  
 
Careful consideration, such as the evaluation of whether or not the sample appears to be 
degraded and if the peak height ratios fall below 0.6, must be made when differentiating 
stutter peaks and a possible mixture. Stutter is typically more pronounced when excessive 
quantities of DNA are placed into the amplification cocktail. Stutter may also appear as 
multiples of the repeat unit (e.g. 8 nucleotides) or may be larger than the amplicon size (+4 
stutter or “up-stutter”). 

 
NOTE: Stutter peaks are believed to be a result of slippage of the Taq polymerase during 

amplification. The GeneMapper® ID software is programmed to detect (i.e. not call 
as an allele) stutter peaks that are less than or equal to 20% of the main peak (defined 
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in the panel manager based upon VDFS validation data) for all loci. This will only be 
applied to the n-(1 repeat) stutter. Examples of stutter peaks are shown in Figure 4.  

 

 
Figure 4. Stutter at the D3S1358 locus, indicated by red circles. 

 
5.2.5.5 If the ratio of the peak height for the smaller peak to the larger peak is less than 20%, the 

allele will be considered to be stutter by the GeneMapper® ID software and no allele will be 
designated even if it is suspected that the peak is a true allele 

 
5.2.5.6 If the ratio of the peak height for the smaller peak to the larger peak is above 20% (this event 

is generally observed in samples containing a high concentration of DNA or the DNA is 
partially degraded), the allele may still be called stutter once all loci have been taken into 
account and both the examiner/analyst and the independent analyzer are in agreement (based 
upon knowledge of the system and experience) that the smaller peak is stutter. 

 
5.2.6 For analysis of sample data, all electropherograms must be visually evaluated by the analyst to ensure that 

artifacts are not mislabeled. Most of these artifacts will be below the 13% global filter cut-off or 20% 
stutter filter cut-off and will not be labeled by the software. However if a peak is mislabeled (e.g., spike, 
pull-up, etc.), the allele call can be electronically edited by the analyst.  
 
5.2.6.1 To electronically edit the allele call of a mislabeled peak, select the peak of interest by right-

clicking on it. 
 

5.2.6.2 If the peak is already labeled, the allele call can be deleted. The user will be prompted to add a 
comment. For Data Bank arrestee and convicted offender samples, all deleted peaks will be 
considered to be “ART” and an allele edit comment is not necessary. 
 

5.2.6.3 Pull-up, spikes, raised baseline, and –A are types of artifacts seen during the analysis of 
sample data. 
 
5.2.6.3.1 Pull-up, an example of which is shown in Figure 3, refers to peaks that are not 

true alleles but result from poor color separation of the raw data or off-scale data 
in one or more channels. Recurrent pull-up due to poor color separation in 
samples indicates the need to complete a new spectral calibration. 
 

5.2.6.3.2 Signal spikes can frequently resemble peaks. Spikes usually occur at the 
same/similar location in more than one color (dye). Spikes are also characterized 
by their very narrow width. GeneMapper® ID has an algorithm that 
discriminates between true peaks and spikes, although, occasionally, the analyst 
may encounter a spike called as an allele. While the signal spike does not result 
from an actual DNA fragment, the software cannot always make this distinction 
and therefore calculates a size in base pairs for the spike. 
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5.2.6.3.3 An example of raised baseline can be seen in figure 5. 
 

 
 

Figure 5. An example of raised baseline at the D8S1179 locus, indicated by the red circle. 
 

5.2.7 It is preferable that the positive and negative controls, random sample and reagent blank associated with 
convicted offender/arrestee samples in an amplification reaction are included in the same capillary 
electrophoresis run. However, if any control sample requires re-injection, the original run sample data 
may be used as long as the associated controls provide the expected results after re-injection. 
 

5.2.8 Each electropherogram will include the peaks from each locus labeled with the designated allelic number, 
base size and the height of the peak. 
 

5.2.9 An independent electronic review must be performed for each sample and will be conducted by the 
technical reviewer using the GeneMapper® ID software. 
 

5.2.10 If an allele is labeled as “off ladder” or “OL”, careful review of the data should be conducted to 
determine if the allele is truly a microvariant/off-ladder allele or the allele is mislabeled (most commonly 
multiple alleles are mislabeled in that instance.)  
 
5.2.10.1 The allelic ladders and size standard for the given sample should be reviewed for accurate 

calling, as described in Chapter 4, Analysis of CE Data. If multiple alleles are mis-labeled, 
this is generally the cause. 

 
5.2.10.2 If a true microvariant or other off-ladder allele is observed (and, if necessary on a sample by 

sample basis, confirmed by re-injection and/or re-amplification of the sample), the 
nomenclature described below will be used. 

 
5.2.11 If an allele is seen in a region “off ladder” or OL alleles, i.e., larger than the largest allelic ladder peak of 

the largest MW locus on the electropherogram, smaller than the smallest allelic ladder peak of the 
smallest MW locus on the electropherogram, or between loci, an allele designation based upon the 
nomenclature referenced in step 5.2.12 will be used.  
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5.2.12 If the allele is seen to the right (higher MW) of the largest allelic ladder peak of the largest MW locus, it 
will be assigned the type of the largest allele of the allelic ladder with a greater than sign (>). If the allele 
is seen to the left of the smallest allelic ladder peak of the smallest MW locus, the allele will be assigned 
the type of the smallest allele of the allelic ladder with a less than sign (<). The "OL" value on the 
electropherogram will be manually changed to reflect the allele designation. 
 

5.2.13 If an allele is seen between two loci and either the locus to the right OR left of the peak contains two 
peaks, the allele will be considered to belong with the locus not containing two peaks. The assignment of 
the allele designation will be based upon the nomenclature referenced in step 5.2.12.  
 

5.2.14 If the allele is to the right of the largest allelic ladder peak of the locus not containing two alleles, it will 
be assigned the type of the largest allele of the allelic ladder with a greater than sign (>). If the allele is 
smaller than the smallest allelic ladder peak of the locus not containing two peaks, the allele will be 
assigned the type of the smallest allele of the allelic ladder with a less than sign (<). The "OL" value will 
be manually changed to reflect the allele designation. 
 

5.2.15 If an allele is seen between two loci and neither the higher nor lower molecular weight locus contains two 
alleles, follow the guidelines outlined in steps 5.2.16 through 5.2.18.  
 

5.2.16 The base pair size for the allele in question will be compared to the base pair values for the largest allelic 
ladder peak of the lower molecular weight locus and to the smallest allelic ladder peak of the higher 
molecular weight locus. An evaluation of the physical location of the allele in question with respect to 
the higher and lower molecular weight loci will be conducted. An evaluation of the RFU values of the 
peaks in question may also help determine to which locus it belongs. 
 

5.2.17 The allele in question will be considered to belong to the locus which is closest in proximity and falls 
within an appropriate size distance from the locus (i.e., one or two repeat units from the largest/smallest 
allelic ladder peak). 
 

5.2.18 Once it has been determined to which locus the allele belongs, if the allele is larger than the largest allelic 
ladder peak it will be assigned the type of the largest allele of the allelic ladder with a greater than sign 
(>). If an allele is smaller than the smallest allelic ladder peak, the allele will be assigned the type of the 
smallest allele of the allelic ladder with a less than sign (<). The "OL" value on the electropherogram will 
be manually changed to reflect the allele designation. 
 

5.2.19 If an allele is less than 500 bp in size, is visually between two allelic ladder peaks of the same locus, the 
GeneMapper® ID program generates a value “off ladder”. The allele will be considered to be a 
microvariant. The allele will be assigned an allele designation of the lower repeat value followed by the 
number of bases in the incomplete repeat. Example: an allele that migrates one base pair below the 
D16S539 14 allele will be designated as a D16S539 13.3. The "off ladder" value on the elecropherogram 
will be manually changed to reflect the allele designation. 
To determine a microvariant allele call in the GeneMapperTM ID software, highlight the sample in 
question and an allelic ladder under the “Samples” tab. Click on “Display plots” and magnify the peak in 
question heavily. The ladder will also magnify automatically. Show bins, if needed, by cliking on “Bins” 
under the “View” header. The bin will appear as gray shading behind each peak. Compare the base pair 
size of the peak in question to the surrounding known ladder allele(s) to determine the size of the peak. 
 
NOTE: Microvariants not represented in the allelic ladder may be re-injected and/or re-amplified, if 

necessary, on a sample by sample basis in order to confirm the base pair size of the fragment. 
 

5.2.20 To indicate the gender of the contributor of a particular biological sample the Amelogenin locus may be 
used. A biological sample exhibiting a single peak at approximately 106 bp (X allele) will generally be 
considered to have originated from a female individual. A biological sample exhibiting a peak at 
approximately 106 bp (X allele) and a peak at approximately 112 bp (Y allele) will generally be 
considered to have originated from a male individual. If only a Y allele is obtained or only an X allele is 
obtained from a known male sample, the results at the Amelogenin locus will be reported as 
inconclusive. 
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5.2.21 For a typing result to be reported, all controls must give the expected result and have been treated 
appropriately (i.e., same or longer injection times and/or same or larger volumes loaded into the injection 
cocktail). 

 
5.2.22 Reagent Blanks 

 
5.2.22.1 If a signal (peak) is detected in a reagent blank at a single locus, the test results associated 

with the reagent blank will be evaluated against the samples around it to determine whether 
the result can be used or if the sample has to be reinjected, reextracted or reamplified. If a 
reinjection does not reproduce the signal (peak), the reagent blank result can be used. If a 
reinjection reproduces the signal (peak) the samples will be re-extracted and/or re-amplified. 

 
5.2.22.2 If a signal (peak) is detected in a reagent blank at multiple loci, the test results for all loci will 

be considered inconclusive and all samples associated with the reagent blank will be re-
extracted and/or re-amplified. 

 
5.2.23 Positive Amplification Control 

 
5.2.23.1 The positive amplification control DNA must elicit the "known" genotype for each locus as 

specified in 5.1.6. If an allele is detected in the positive control DNA at a specific locus that is 
not consistent with the known genotype or if no result is obtained at a single non-CODIS core 
locus, the samples will be re-amplified. 
 

5.2.24 Negative Amplification Control 
 
5.2.24.1 If a signal (peak) is detected in the negative amplification control at a single locus, the test 

results associated with the negative amplification control will be evaluated against the 
samples around it to determine whether the result can be used or if the sample has to be 
reinjected, reextracted or reamplified. If a reinjection does not reproduce the signal (peak), the 
negative amplification control result can be used. If a reinjection reproduces the signal (peak), 
the samples will be re-amplified. 
 

5.2.24.2 If a signal (peak) is detected in the negative amplification control at multiple loci, the test 
results for all loci will be considered inconclusive and all samples will be re-amplified. 
 

5.2.24.3 If it is determined that a sample contains stutter peaks at a majority of the loci and other 
artifactual peaks are visible throughout the electropherogram due to injecting too much and/or 
amplifying too much sample DNA, the sample may be re-injected using a reduced injection 
time and/or using less amplified DNA in the injection cocktail following the guidelines 
described in Chapter 3. Samples may also be re-amplified with less template DNA and then 
re-typed. If, however, the accurate profile can be determined from the original sample profile 
by both the examiner and the independent analyst, then the data may be used. 
 

5.2.25 For convicted offender and arrestee sample analysis, the Random Sample profile, when searched in 
CODIS, must elicit the correct result. If the DNA sample number identified as a result of the search is 
different from the DNA sample number on the master list (maintained by the State CODIS Administrator 
or designee) all samples associated with the Random Sample will be re-extracted and/or re-amplified if 
possible. 
 

5.2.26 Convicted offender and arrestee samples are expected to exhibit single source profiles. If more than one 
DNA profile is seen in a single sample, the sample will be re-extracted and/or re-amplified. 
 

5.2.27 If no typing result is observed for the Random Sample (for convicted offender and arrestee sample 
analysis) or the Control DNA (positive amplification control) at a particular non-CODIS core locus, all 
samples at that locus will be considered inconclusive. If the locus is deemed necessary, the sample(s) 
associated with the Random Sample or Control DNA will be re-amplified and typed. 
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5.3 When a peak with a high rfu value (e.g.. >1000) and a peak with a low rfu value (e.g. <150) are observed within a 
single locus and the peaks are separated by greater than one repeat unit, the difference in peak height could be the 
result of the inability of the primer to perfectly hybridze to the template in the flanking region of one of the alleles. 
In order to determine if a DNA profile containing peaks with a difference in intensity is a result of primer mis-
pairing or a mixture of biological material from more than one source, the analyst must take into account all of the 
loci, use experience and/or the heterozygous percent intensity values to make an informed decision. If the 
percentage values obtained from the ratio of the signal (RFU) for the highest peak to the smallest peak is equal to 
or greater than the established values (listed below), both peaks within the locus may be considered to have 
originated from a single donor. The following heterozygous percent intensity values will serve as a guide. 
Databank samples are expected to be single source, however an evaluation of the heterozygous percentage may be 
appropriate in instances where the sample may be contaminated.  
 
Locus 

  
Heterozygous 
Peak Balance 

 

Minimum 
observed peak 

balance  

Locus 
 

Heterozygous 
Peak  

Balance 

Minimum 
observed peak 

balance 
Penta E 74% 33% VWA 86% 66% 

D18S51 80% 61% Amelogenin 80% 64% 

D21S11 86% 72% Penta D 84% 61% 

TH01 74% 53% CSF1PO 75% 61% 

D3S1358 86% 73% D16S539 77% 62% 

FGA 74% 50% D7S820 83% 59% 

TPOX 81% 59% D13S317 81% 55% 

D8S1179 93% 83% D5S818 90% 85% 

 
Note: Data generated from internal validation conducted by the Virginia Department of Forensic Science using 500 pg 

of input DNA 
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APPENDIX A – CONVERSION FACTORS AND OTHER USEFUL INFORMATION 
 
I. CONVERSION FACTORS 
 

One microgram = 1 µg = 1 x 10-6 g = 1000 ng 
 
One nanogram = 1 ng = 1 x 10-9 g = 1000 pg 
 
One picogram = 1 pg = 1 x 10-12 g = 1 x 10-3 ng  
 
One liter = 1 L = 1000 mL 
 
One milliliter = 1 mL = 1 x 10-3 (0.001) L = 1000 µL 
 
One microliter = 1 µL = 0.001 mL = 1 x 10-3 mL = 1 x 10-6 L 

 
II. CONCENTRATIONS 
 

A. Concentration can be expressed several ways: 
 

1. Weight percent = (mass A/total mass of solution) x 100 
 

or simplified: Wt %A = (gA/100 mL of solution) x 100 
 

2. Volume percent = (volume A/total volume of solution) x 100 
 

or simplified: Volume %A = (volumeA/100 mL of solution) x 100 
 

3. Molarity (M): M = no. moles solute A/no. liters solution  
 

 = molecular weight of solute A in 1000 mL solution 
 

where 1 mole of A = 1 gram formula weight of A 
 

4. Normality (N) = no. MW/no. liters solution 
 

where in acid-base reactions:  
 

MW acid = weight of acid which reacts with 1 mole of OH- 
MW base = weight of base which reacts with 1 mole of H+ 

 
The normality of a given reagent depends on the reaction in which it participates. (Example: 1 L of 1M 
H3PO4 which can have N = 1, 2 or 3 depending upon the reaction in which it is involved.) Because of 
ambiguities, the concept of normality is to be used carefully. 

 
B. Examples: 

 
1. Prepare 50% solution of polyethylene glycol (PEG): 

 
Place 50 g of PEG in a flask and bring to a volume of 100 mL with H2O. 

 
Wt % PEG = (50 g/100 mL) x 100 = 50% 

 
2. Prepare 100 mL of 2M HCl from a stock solution of 12M HCl. (The question is how much stock 

solution of 12M HCl is needed?) 
 

Conc of Stock Soln = Cs = 12M Conc of Final Soln = Cf = 2M 
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Volume of Stock Soln = Vs = ? Volume of Final Soln = Vf = 0.1 L 
 

Cs • Vs = Cf • Vf 
 

Vs = (Cf • Vf)/Cs = 2(0.1)/12 = 0.2/12 = 0.0167 L 
 

Vs = 0.0167 L = 16.7 mL 
 

Answer: Take 16.7 mL of 12M HCl and dilute to final volume of 100 mL to give 2M HCl.
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APPENDIX B - REAGENTS 
 
1. This appendix describes the preparation of reagents necessary for the DNA analysis. For each reagent listed, the 

company and catalog number is included. As a reagent is prepared, it will be labeled to include the following 
information: 

 
Identity 
Concentration 
Lot number 
Date of preparation 
Initials of preparer 
Date of expiration 

 
and if appropriate:  

 
Date of autoclaving 
Storage requirements 

   
2. All reagents will be prepared with Type I water, unless other wise stated. 
 
3. All chemicals and reagents will be stored according to the manufacturers' specifications. All chemicals containing 

biologicals will be disposed of in biohazard bags. Waste organic reagents and Ethidium Bromide will be placed in 
designated waste containers in a hood and removed from the laboratory by an appropriate means of disposal. All 
other reagents can be disposed of in the laboratory sink. 

 
4. Any changes in chemical supply companies will be carefully checked by the Section Supervisor to ensure the 

chemical being provided meets the specifications necessary for the reagent. Any changes in chemical supply 
companies will be brought to the Biology Program Manager’s attention so the list can be updated as necessary. 

 
5. Concentrations preceding reagent components reflect the final concentrations of that specific component in the 

resulting mixture. 
 
6. When a reagent is diluted and used by a number of examiners and retained, a lot number must be created and the 

reagent must be traceable to the reagent log. The container with the diluted reagent must contain the reagent stock 
lot number, the date the dilution was prepared, and the initials of the individual preparing the dilution. If a stock 
solution is diluted and used once and discarded or the dilution is used only by the examiner preparing the dilution, a 
new lot number does not need to be assigned or recorded in the reagent log. The Control DNA (positive 
amplification control) is an example of a reagent where this applies. The original reagent stock lot number will be 
used. 

 
AMPLITAQTM GOLD DNA POLYMERASE 

Expiration date: Manufacturer's expiration date 
Purchased from Applied Biosystems, Foster City, CA, Catalog number N808-0243 (6 pack) or N808-0244 (12 
pack). 

 
ETHANOL, 95% 

Expiration date: Dispose of when necessary 
Purchased as Reagent Alcohol (190 Proof) from VWR, Bridgeport, NJ, Catalog number 6590-1, 4 L bottle. 

 
GENETIC ANALYSIS BUFFER WITH EDTA (10x) 

Expiration date: Manufacturer's expiration date    
Purchased from Applied Biosystems, Foster City, CA. PN 402824, 25 mL each.  

 
HI-DITM FORMAMIDE 

Expiration date: Manufacturer's expiration date    
Purchased from Applied Biosystems, Inc., Foster City, CA, PN 4311230, 25 mL each. Aliquot into 200 µL or 1.2 
mL aliquots and store at -20oC. 
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PERFORMANCE OPTIMIZED POLYMER – 4 (POP-4) 
Expiration date: Manufacturer’s expiration date 
Purchased from Applied Biosystems, Foster City, CA. PN 4363752 (3.5 mL) OR PN 4352755, (7 mL) 

 
PHOSPHATE-BUFFERED SALINE (PBS), 1X, pH 7.2 

Expiration date: Manufacturer’s expiration date if listed, otherwise no expiration date 
Purchased from Lonza, Walkersville, MD., Catalog # 17-516Q 1L bottle. 

 
POWERPLEX 16 SYSTEM KIT 

Expiration date: Manufacturer’s expiration date 
Purchased from Promega, Madison, WI., Catalog Number DC6531 for 100 reaction kit or DC6530 for 400 reaction 
kit. 
Kit components included (expiration date same as kit unless specified): 
• POWERPLEX 16 PRIMER PAIRS 
• POWERPLEX 16 ALLELIC LADDER 
• GOLD ST*R 10X BUFFER - Purchased from Promega, Madison, WI. Catalog Number DM2411, 1.2 mL tube 
• FLUORESCENT INTERNAL LANE STANDARD 600 
• CONTROL DNA (GM9947A CELL LINE) - Purchased from Promega Corporation, Madison, WI., 250 ng 

tube, 10 ng/µL, Catalog number DD1001.  
 
POWERPLEX MATRIX STANDARDS 3100/3130  

Expiration date: Manufacturer’s expiration date  
Purchase from Promega, Madison, WI. Catalog Number DG4650. 

 
QIAamp® DNA BLOOD MINI KIT 

Expiration date: Refer to individual kit component expiration dates. 
Purchased from QIAGEN, Inc., Valencia, CA, Catalog number 51104 for 250 sample kit. 
Kit components included: 
• QIAGEN® AE ELUTION BUFFER - Purchased from QIAGEN, Inc., Valencia, CA, Catalog number 19077. 
 Expiration date: Twelve months from date of receipt into the laboratory 
• QIAGEN® AL LYSIS BUFFER - Purchased from QIAGEN, Inc., Valencia, CA, Catalog number 19075. 
 Expiration date: Twelve months from date of receipt into the laboratory 
• QIAGEN® AW1 WASH BUFFER (concentrate) - Purchased from QIAGEN, Inc., Valencia, CA, Catalog 

number 19081. 
Expiration date: Twelve months after dilution with ethanol 

 Before initial use, dilute concentrate with 95% ethanol according to the following table: 
  

AW1 concentrate Ethanol  Final volume 
 

95 mL  125 mL  220 mL 
   

Once the  QIAGEN® AW1 wash buffer has been diluted with ethanol, store the buffer at room temperature. 
• QIAGEN® AW2 WASH BUFFER (concentrate) - Purchased from QIAGEN, Inc., Valencia, CA, Catalog 

number 19072. 
Expiration date: Twelve months after dilution with ethanol 

 Before initial use, dilute concentrate with 95% ethanol according to the following table: 
  

AW2 concentrate Ethanol  Final volume 
 
66 mL  160 mL  226 mL 

 
Once the QIAGEN® AW2 wash buffer has been diluted with ethanol, store the buffer at room temperature. 

• QIAGEN® PROTEASE - Purchased from QIAGEN, Inc., Valencia, CA, Catalog number 19155 (125 mg) or 
19157 (4 x 125 mg). 
Expiration date: 6 months after sample is reconstituted if stored at –20 °C. 

2 months after sample is reconstituted if stored at 4 °C. 
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Reconstitute with supplied QIAGEN® protease solvent before initial use according to the  table below: 
 

QIAGEN® Protease Protease solvent   
 
110 mg  5.5 mL 

 
If the QIAGEN Protease is purchased separately from the kit, then it is to be reconstituted with 7 mL of Type I 
water for each 125 mg bottle. 

• QIAGEN® PROTEASE SOLVENT 
 Expiration date: Twelve months from date of receipt into the laboratory 

 
QIAamp® 96 DNA BLOOD KIT 

Expiration date: Refer to individual kit component expiration dates as specified under QIAamp® DNA BLOOD 
MINI KIT 
Purchased from QIAGEN, Inc., Valencia, CA, Catalog # 51161 for 4 plate kit, or #51162 for 12 plate kit. 
Kit components included: 
• QIAGEN® AE ELUTION BUFFER 
• QIAGEN® AL LYSIS BUFFER  
• QIAGEN® AW1 WASH BUFFER (concentrate) 
• QIAGEN® AW2 WASH BUFFER (concentrate) 
• QIAGEN® PROTEASE  
• QIAGEN® PROTEASE SOLVENT
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APPENDIX C - MAINTENANCE OF THE ABI 3130XL GENETIC ANALYZER 
 

1 General Maintenance Schedule for the 3130xl 
 
Table 1. Maintenance Tasks 
 

Task Frequency 
Ensure adequate levels of buffer and water in reservoirs Before each run 

 
Ensure the level of buffer in the buffer jar reaches the red 

line. The overflow hole should not be occluded. 

 
Before each run 

 
Replace the water and 1X running buffer in the reservoirs 

and make sure the outside of the reservoirs are dry. 

 
Every 48 hours or before each run, 

whichever comes last 
 

Check for bubbles in the pump block, lower polymer 
block, interconnect tube, polymer supply tube, and 

channels. Remove all bubbles with the Bubble Remove 
wizard. 

 
Before each run 

 
Check the loading-end header to ensure the capillary tips 

are not crushed or damaged. 

 
Before each run 

 
Ensure that sufficient volume of polymer is present in the 

bottle for run. 

 
Before each run 

 
Ensure the pump block and lower polymer block are 

securely fit on the instrument. 

 
Before each run or daily,  

whichever comes last 
 

Clean the instrument surfaces. 
 

As needed 
 

Check for leaks around the array knob, interconnecting 
tube nuts, and check valve. 

 
Before each run or as needed 

  
Replace the polymer using the Replenish Polymer Wizard Weekly or as needed. 

 
Check the storage conditions of used arrays, if applicable. 

 
Weekly 

 
Restart the computer and instrument 

 
Weekly 

 
Run the Water wash wizard. Flush the array port during 

this wizard, whether or not bubbles are present in the array 
port. 

Monthly or as needed 

 
Flush the water trap. 

 
Monthly or as needed 

 
Defragment the PC’s hard drive (only C and E). 

 
Monthly or as needed 

  
Clean the drip tray. As needed 

 
Change the array. 

 
As needed 

 
Remove any dried polymer from the capillary tips. Use a 

lint-free wipe moistened with deionized water. 

 
As needed 
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2 Wizards 
 
Wizards are automated instrument processes which allow the user to perform a variety of tasks. Each wizard has 
been designed with specific instructions to achieve the purpose of the wizard. The wizards are accessed by selecting 
the desired wizard from the “Wizards” menu and activated when the instrument name is selected in the tree pane. 
The wizards include: 
 
• Install Array- used to install or replace capillary arrays 
• Change Polymer Type- change to a different polymer type (ex. POP-4 to POP-6) 
• Replenish Polymer – replace the polymer in the PDP with polymer with the same or different lot number. 
• Bubble Remove – remove bubbles (>0.2mm) in the PDP chamber, channels, tubing, as well as the array port 
• Water Wash – rinse the PDP chamber, lower polymer block, channels and tubing 
• Instrument Shutdown – prepares the instrument for long term storage and removes the capillary array 
• Autosampler Calibration – calibrates the positions on the Autosampler 
• Update Cap Array Info – correct or update capillary array information 
 

3 Replacing the Polymer using the Replenish Polymer Wizard 
 
3.1.1 NOTE: Only use the replenish polymer wizard if the polymer type is not changing. If a different polymer type 

is desired, select the Change Polymer Type Wizard. 
 
3.2 In the Data Collection Software 3.0, select Wizards> Replenish Polymer Wizard 
 
3.3 Follow the directions given in the wizard to load fresh polymer on the instrument.  
 
3.4 Record the date, lot number, expiration date, and polymer type in the 3130xl Instrument Log.  

 
4 Flushing the Water Trap 

 
4.1 The water trap in the polymer delivery pump creates a water barrier between the pump chamber seal and the 

actual pump. The water trap should be flushed with Type I H2O on a monthly basis or as needed to wash out 
any polymer and to clear bubbles. The trap should be left filled with type I H2O. 

 
4.1.1 Fill a 20 mL luer lock syringe with type 1 H2O. Remove any bubbles from the syringe. 
 
4.1.2 Attach the syringe to the forward facing luer fitting at the top of the pump block, as shown in Figure 

1. Hold the fitting with one hand while threading the syringe onto the fitting with the other hand.  
 
4.1.3 Open the luer fitting by grasping the body of the fitting and turning it and the attached syringe 

approx. one-half turn counterclockwise. 
 
4.1.4 Open the exit fitting at the top left side of the pump block by turning it approximately one-half turn 

counterclockwise. 
 
4.1.5 Hold an empty beaker or tube under the exit fitting to catch approximately 5 mL of waste. Flush the 

trap by pushing steadily on the syringe plunger. Take approximately 30 seconds to flush 5 mL of 
type 1 H2O through the trap.  

 
4.1.6 Close the luer fitting then the exit fitting by turning each clockwise until the fittings seal against the 

block. Do not over-tighten the fittings.  
 
4.1.7 Remove the syringe from the luer fitting. Hold the fitting with one hand while turning the syringes 

counterclockwise with the other hand.  
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Figure 1. Diagram of the pump block for flushing the water trap. 
The solid arrow points to the luer fitting described in 4.1.2 above. 

The dashed arrow points to the exit fitting described in 4.1.4. 
 

Figure reproduced from Applied Biosystems 3130/3130xl Genetic Analyzers (2004) 
Maintenance and Troubleshooting Guide. 

 
5 Rinsing and Filling Buffer and Water Reservoirs 

 
5.1 Ensure the instrument doors are closed. 
 
5.2 Press the TRAY button on the outside of the instrument to bring the autosampler to the forward position. 
 
5.3 Wait until the autosampler has stopped moving and then open the instrument doors. 
 
5.4 Remove the anode buffer reservoir by gently pulling down and twisting slightly. 
 
5.5 Remove the cathode buffer reservoir and H2O reservoirs. 
 
5.6 Discard the solutions into the sink and rinse out the reservoirs with ddH2O or Type 1 H2O. 
 
5.7 Dry with a lint-free wipe the cathode and anode reservoirs and then fill the reservoir to the fill line with 1X 

Genetic Analyzer buffer. 
 
5.8 Fill the water reservoirs to the fill line with ddH2O or Type 1 H2O(approximately 17 mL). 
 
5.9 Place a clean septa strip on each reservoir and dry the outside of the reservoirs using a lint-free wipe. Be sure 

that the septa are dry and fitted flush on the tops of the reservoirs in order to prevent damaging the capillary 
tips. 

 
5.10 Place the reservoirs into position on the autosampler as shown in Figure 2. 

 

 
 

Figure 2. Position of water and buffer reservoirs on the 3130xl. 
 

Figure reproduced from Applied Biosystems 3130/3130xl Genetic Analyzers (2004) 
Maintenance and Troubleshooting Guide. 

 
6 Changing the Capillary Array 

 
6.1 The capillary array should last approximately 100 runs.  
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6.2 The capillary array may need to be replaced if poor sizing precision or allele calling results, or if poor 
resolution and/or decreased signal intensity is demonstrated.  

 
6.3 Close the oven and instrument doors, and then press the “Tray” button. 
 
6.4 In the Data Collection 3.0 software, select Wizards>Install Array Wizard. 
 
6.5 Open the instrument and oven doors 
 
6.6 Follow the directions given in the wizard to install or replace an array. 
 
6.7 Click Finish when done. 
 
6.8 Close and lock the oven door. 
 
6.9 Note: if you have replaced the array with one of a different length, a new spectral calibration must be 

completed for the dye set and array length combination. 
 
6.10 Use the Update Capillary Array Info wizard (Wizard>Update Capillary Array Info) to identify the capillary 

array length and serial number information. The capillary serial number and date must also be added to the 
3130xl instrument log.  

 
6.11  A new spatial calibration must be completed. See 7 below for directions. 

 
7 Performing a Spatial Calibration 

 
7.1 A spatial calibration is used by the instrument to correlate the signal from each capillary with the signal 

detected by the CCD camera.  
 

7.2 A spatial calibration must be performed when the capillary array is installed or replaced, any time the 
capillary array is removed from the detection block, and when the instrument is moved. 

 
7.3 Creation of the spatial calibration file 

 
7.3.1 On the left side of the Data Collection Software, select GA Instruments>ga3130xl>3130xl>Spatial 

Run Scheduler, as shown in Figure 3. 
 

 
 

Figure 3. Spatial Run Scheduler 
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7.3.2 In the spatial protocols section on the right side of the screen, select either: 
 

7.3.2.1 Protocol>3130 SpatialFill_1, if the capillaries do not contain fresh polymer, or 
 

7.3.2.2 Protocol>3130 SpatialNoFill_1, if the capillaries do contain fresh polymer. 
 

7.3.3 Click Start. The calibration run lasts approximately 2 min (6 min when filling the capillaries as 
well.) 

 
7.4 Evaluation of the spatial calibration file 

 
7.4.1 The spatial calibration profile should be evaluated according to: 
 

• Peak Height – Similar peak heights should be observed for all peaks. 
• Orange Crosses – One orange cross should mark the top of each peak. 
• Peak Shape – Each peak should be sharp. Small shoulders are acceptable. 
• Spacing – The difference between adjacent peaks should be approximately 15 pixels. 

 
7.4.2 See Figure 4 for an example of an acceptable spatial calibration profile. 

 

 
 

Figure 4. An example of an acceptable spatial calibration profile. 
 

7.4.3 In the Capillary Positions table, ensure that the values in both the Left spacing and Right spacing 
columns range between 13 and 16 pixels.  

 
7.4.3.1 To move the cross, type in a new value in the Positions box for the capillary of interest 

and press Enter. 
 

7.4.4 If the calibration passed, click Accept to write the calibration data to the database and the *.ini file. 
If the calibration failed, click Reject and repeat the spatial calibration.  

 
7.4.4.1 Poor spatial calibration is most often due to a dirty detection window or one or more 

broken capillaries. The capillary array detection cell should be removed from the 
instrument and the mirrored side cleaned with methanol (air dry) to clean the window. 
While the detection cell is off the instrument, ensure that the capillaries are not broken 
near the detection cell. 

 
8 Performing a Spectral Calibration 

 
8.1 The spectral calibration creates a matrix that is used during a run to reduce the raw (collected) data from the 

instrument to the 4-dye or 5-dye data stored in the sample files.  
 

8.2 The spectral calibration is specific to each dye set. 
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8.3 The spectral calibration needs to be performed when using a new dye set on the instrument, when the 
capillary array length or polymer type is changed, after the laser or CCD camera have been serviced/replaced, 
or if you see extensive pull-up or pull-down peaks in the data. 

 
Note: For each dye set, a spectral calibration for each capillary array length and polymer type combination 

must be created. 
 

Note: A new spectral cannot be associated with previously-collected data. For example, if a new kit (with a 
new dye set) is used on the instrument, it is necessary to perform a spectral calibration before running 
the samples with that new kit. 

 
8.4 For Fragment analysis, two common dye sets are:  
 

• Dye Set F – used with PowerPlex® 16, AmpFlSTR® COfiler® Kit, AmpFlSTR® Profiler Plus® Kit, etc. 
• Dye Set G5 – used with AmpFlSTR® YfilerTM Kit, AmpFlSTR® Identifiler® Kit, AmpFlSTR® Minifiler® 

Kit, etc. 
 

8.5 For Dye Set F in conjunction with the PowerPlex® 16 kit, the Promega PowerPlex® Matrix 3100/3130 should 
be used. (For the AmpFlSTR® COfiler® Kit or AmpFlSTR® Profiler Plus® Kit, the DS-32 Matrix Standards 
should be used.) 

 
8.6 For Dye Set G5, the DS-33 Matrix Standards should be used. 

 
8.7 Preparing the matrix standard for PowerPlex® 16  

 
8.7.1 For PowerPlex® 16, remove the matrix standards (P/N DG4650, Promega Corp.) from the freezer, 

thaw, and vortex to mix thoroughly, but do NOT centrifuge.  
 

8.7.2 Dilute each of the concentrated dyes 1:10 with nuclease-free water (ex. 1 µL concentrated dye + 
9 µL nuclease-free water). Using these dilutions, then mix 5 µL of each diluted dye with 480 µL Hi-
DiTM formamide for a total volume of 500 µL. 

 
8.7.3 Vortex the formamide/matrix standard mixture thoroughly. Do not centrifuge the mixture. 

 
8.8 Loading the samples 

 
8.8.1 Add 25 µL of the formamide/dye mix to each well of the first two columns of a 96-well plate.  

 
8.8.2 Seal the plate by laying the septum flat on the plate. 

 
8.8.3 Inspect the plate and septum to ensure that the septum fits snugly and flush on the plate. 

 
8.8.4 Denature the samples at 95oC for 3 minutes then immediately chill the plate in a freezer block for 3 

minutes. 
 

8.8.5 Inspect the plate to ensure no bubbles are located at the bottom of a well. If so, either briefly 
centrifuge the plate or use a pipet tip to remove the bubbles. 

 
8.8.6 Leave the plate on ice until ready to prepare the plate assembly and place the assembly on the 

autosampler. 
 

8.8.7 Assemble the plate assembly by placing the sample plate into the black plate base. Snap the white 
plate retainer onto the plate and plate base. Note: Verify that the holes of the plate retainer and the 
septum are aligned. If not, reassemble the plate assembly. 
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8.9 Creating a Spectral Instrument protocol 
 

8.9.1 Before creating the protocol, go into the Module Manager and select “New”. Select “Spectral” in the 
“Type” drop-down list and select “Spec36_POP4” in the “Template” drop-down list. Confirm or 
change the following settings: 

 
Inj. kV:  3 
Inj. Secs:  5 
Data Delay Time: 100 
Run time:  800 seconds 

 
8.9.2 On the left side of the Data Collection software window, choose GA 

Instruments>ga3130xl>Protocol Manager to open the Protocol Manager, as shown in Figure 5. 
 

 
 

Figure 5. Creation of a protocol for a spectral calibration. The solid arrow points to 
the appropriate selection on the menu at the left side of the screen. The dashed arrow (near bottom) 

points to the “New” button for creating a new instrument protocol, as described in 8.9.2 below. 
 

8.9.3 In the Instrument Protocols box, click “New…”, which opens the Protocol Editor dialog box. 
 

8.9.4 Complete the Protocol editor dialog box: 
 

• Type a name for the protocol, typically including “Spectral” and the dye set utilized in the title. 
• Select Spectral in the Type drop-down list. 
• Select the correct dye set for your run. For the PowerPlex® 16 system, select dye set F. 
• Select the polymer and array length from the drop-down lists, i.e. POP4, 36 cm 
• Select your chemistry file (Matrix Standard or Sequencing Standard) in the Chemistry drop-

down list. For the PowerPlex® 16 system, select “matrix”. 
• In the Run Module drop-down list, select the run module you created in step 8.9.1 
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• These modules are named with the array length and polymer type in the title. For example, 
Spect36_POP4 is the name of the run module that should be used when the array length is 36 
cm and the polymer type used is POP-4.  

• Select “Edit Parameters”. Change the lower condition bound to 4.0 and change the upper 
condition boud to 12.0. Select “OK” in the “Edit Parameters” window and select “OK” in the 
“Protocol Manager”. 

 
8.10 Performing the Spectral Calibration Plate Record 

 
8.10.1 On the left side of the Data Collection software window, choose GA Instruments>ga3130xl> 

3130xl>Plate Manager to open the Plate Manager, as shown in Figure 6. 
 

 
 

Figure 6. Plate Manager for creation of plate for spectral calibration. The solid arrow points to 
the appropriate selection on the menu at the left side of the screen. The dashed arrow (near bottom) 

points to the “New” button for creating a new plate record, as described in 8.10.2 below. 
 

8.10.2 Click “New” to open the New Plate dialog box and fill out as indicated: 
 

8.10.2.1 Type a name for the plate – typically a combination of the date, “Spectral”, and kit type. 
 
8.10.2.2 In the Application field, select “Spectral Calibration” 
 
8.10.2.3 In the Plate Type field, select “96-well” 
 
8.10.2.4 Enter “DFS” for the Owner Name field. 
 
8.10.2.5 Enter your initials in the Operator Name field. 
 
8.10.2.6 Click OK. 
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8.10.3 The Spectral Calibration Plate Editor dialog box will appear, as shown in Figure 7. 
 

 
 

Figure 7. Spectral Calibration Plate Editor 
 

8.10.4 In the row corresponding to the location of your first sample, select: 
 

8.10.4.1 A sample name in the “Sample Name” column. The value “100” automatically appears in 
the Priority column. There is no need to change this value. 

 
8.10.4.2 Comments may be entered in the “Comment” column, but are not necessary. 
 
8.10.4.3 In the “Instrument Protocol 1” select the protocol name created in 8.9, above.  

 
8.10.5 Select the entire row by clicking on the sample well number, such as A01. Select Edit>Fill Down 

Special. This will populate the rows corresponding to your run.  
 

8.10.6 Click “OK”. The Plate record is now complete and the spectral calibration can be completed after 
loading the plate onto the instrument and final preparation of the instrument. 

 
8.11 Running the Spectral Calibration Plate 

 
8.11.1 The plate assembly should be placed in the instrument. 
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8.11.2 On the left side of the Data Collection software window, choose GA Instruments>ga3130xl> 
3130xl>Run scheduler>Plate View to see the listing of prepared plates, as shown in Figure 8. 
 

 
 
Figure 8. Run scheduler for spectral calibration plate. The solid arrow points to the appropriate selection 

on the menu at the left side of the screen. The dashed arrow points to the “Find All” button 
for finding the plate record created in 8.10. 

 
8.11.3 Choose “Find All” to see a listing of all plate records. Alternatively, an advanced search can be 

completed. The plate name from 8.10.2 can be used to find the spectral plate of interest. Select 
“Search” and “Advanced” in the “Type of Search” drop-down list. 
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8.11.4 Once the plate of interest is found, select the plate record by clicking on the plate name. Click on the 
plate position indicator (grid) which corresponds to the location in which the plate resides, as 
completed in 8.11.1 above, shown in Figure 9. The plate map color will change from yellow to green 
to indicate that the plate is successfully linked. In the toolbar or the Data Collection software, click 
the green arrow                        near the top of the screen to begin the run. Click OK when the dialog 
box appears (“You are about to start processing plates…”). 
 

 
 

Figure 9. Plate Editor. The arrow points to the plate position indicator grid. 
 

8.12 Evaluating the Spectral Calibration Data 
 

8.12.1 Viewing the Pass/Fail Status after the run 
 

8.12.1.1  On the left side of the Data Collection software window, choose GA 
Instruments>ga3130xl> 3130xl>Instrument Status>Event Log to see the event messages. 

 
8.12.1.2 In the “Event Messages” section of the window, view the pass/fail status of each 

capillary. Each capillary (1-16, for the 3130xl) should have a Q-value (q) and a condition 
number (c) in the range shown in Table 2. 
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Table 2. Acceptable condition number range and Q-values for analysis of 
spectral calibration data. 

 

Dye Set Acceptable Condition 
Number Range (c) 

Acceptable 
Q-value (q) 

Fragment Analysis   
D 4 – 8.5 above 0.95 
F 6 – 12 above 0.95 

E5 2.5 – 4 above 0.95 
G5 8.5 – 14.5 above 0.95 

Any other  
4- or 5-dye set 1 – 20 above 0.80 

 
8.12.2 Assessment of the Spectral Profiles and Raw Data 

 
8.12.2.1 After assessing the pass/fail status of the capillaries in 8.12.1, the spectral calibration 

profile for each capillary must be assessed.  
 

8.12.2.2 On the left side of the Data Collection software window, choose GA 
Instruments>ga3130xl> 3130xl>Spectral Viewer to see the spectral data, as shown in 
Figure 10. 

 

 
 

Figure 10. Spectral Viewer. The solid arrow points to the appropriate selection on the menu 
at the left side of the screen. The dashed arrow (near bottom) points to passing wells (green) 

indicated on the plate diagram. 
 

8.12.2.3 In the “Dye Set” drop down list, choose the dye set utilized. 
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8.12.2.4 In the “List of calibrations for Dye Set ___”, choose the spectral just created by ensuring 
the date and time correspond to that run. Do not click “set” until the data has been 
verified as acceptable.  

 
8.12.2.5 Each well containing spectral sample of the 96-well plate is colored green (if passing) in 

the plate diagram, as shown in Figure 10. Each well can be clicked to verify the spectral 
profile and raw data for each independently. A failing capillary is colored tan (or yellow 
when selected).  

 
8.12.2.6 Verify that the spectral and raw data profiles for each well are acceptable by meeting the 

following criteria: 
 

8.12.2.6.1 For 4-dye chemistry (such as PowerPlex® 16), the order of peaks in the 
spectral (top) profile should be: blue-green-yellow-red (left to right). For 5-
dye chemistry, the order of the peaks in the spectral (top) profile should be 
blue-green-yellow-red-orange (left to right). If the peaks are not in the 
correct order, the calibration run has failed. 

 
8.12.2.6.2 The order of peaks in the raw data (bottom) profile should be:  

 
8.12.2.6.2.1 Sequencing (4-dye): red-yellow-blue-green (left to right) 
 
8.12.2.6.2.2 Fragment Analysis (e.g., STRs) – 4-dye: red-yellow-green-

blue and 5-dye: orange, red-yellow-green-blue. 
 
8.12.2.6.2.3 If the peaks are in the wrong order or extraneous peaks are 

affecting the spectral profile, the calibration run has failed.  
 

8.12.2.6.3 The peaks in the spectral profile should not contain “gross overlaps, dips or 
other irregularities”. If so, the calibration has failed. A proper looking 
spectral profile is shown in Figure 12. 

 

 
 

Figure 11. An example of a proper spectral calibration profile for PowerPlex® 16. 
 

8.12.2.7 If the spectral profile passes, the file name can be changed to reflect the date, dye set, 
array length, and polymer type by clicking “Rename”. 

Data Bank PowerPlex® 16 Procedures Manual DFS Document 211-D400 
Issued by Biology Program Manager Revision 1 
Issue Date: 24-July-2014 Page 64 of 82 

 
COPYRIGHT © 2014 

VIRGINIA 
DEPARTMENT 

OF 
FORENSIC SCIENCE 

 
 
 

UNCONTROLLED 
COPY 



Appendix C – Maintenance of the ABI 3130xl Genetic Analyzer 
 

8.12.3 Activating a Spectral Calibration File 
 

8.12.3.1 Note: every new spectral calibration is automatically the active one for that dye set, 
unless manually changed. For example, if a spectral calibration were repeated but the first 
spectral was optimal, one may wish to choose the first spectral as the active spectral. 

8.12.3.2  On the left side of the Data Collection software window, choose GA 
Instruments>ga3130xl> 3130-4DFS>Spectral Viewer to see the spectral data, as shown 
in Figure 12. 

 
8.12.3.3 In the “Dye Set” drop down list, select the dye set of interest. 

 
8.12.3.4 In the “List of Calibrations for Dye Set: ___”, select the spectral calibration you wish to 

activate. The spectral profile and raw data are then displayed. If the spectral calibration is 
acceptable as described in 8.12.2.6, click “Set”.  

 
9 Long Periods of Inactivity 

 
9.1 If the ABI 3130xl Genetic Analyzer remains unused for an extended period of time (approximately 2 weeks 

or longer), it is recommended that either a blank run (consisting of only formamide and size standard) be 
completed or the capillary array removed and the capillary ends stored in Type I H2O until further use.
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APPENDIX D – STORAGE OF ELECTRONIC DATA 
 
1 Saving Sample files and Project files 
 

1.1 Sample files and project files generated by the databank using the Applied Biosystems, Inc. 3130xl Genetic 
Analyzer and analyzed using the GeneMapper® ID software will be saved onto a storage medium and stored 
according to the following procedures. 

 
1.2 After the data has been technically reviewed and found to be acceptable, the electronic sample files and 

project files will be transferred onto a medium for permanent storage. The storage medium will be labeled 
appropriately to indicate the data files are PowerPlex® 16 samples and with the appropriate plate number. The 
folders may be deleted from the computer after the data has been stored and a backup copy has been made. 

 
1.3 The storage medium will then be stored securely with the databank sample plate documentation in a specified 

location within the laboratory for easy retrieval. 
 
1.4 If a file(s) needs to be subsequently added to the storage medium for a given plate of databank samples, the 

analyst will make arrangements with his/her supervisor to have the storage medium retrieved from storage 
and have the file(s) added to the appropriate storage medium. 
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APPENDIX E – INITIAL SETUP OF GENEMAPPERTM ID AND DATA COLLECTION SOFTWARE 
 
After installation of a new instrument and installation of the GeneMapperTM ID software on a new computer, a number 
of customizations must be made. These include defining: panels and bin sets, the size standard, plot settings, and table 
settings. If the new computer will also be used to control the instrument, appropriate protocols, modules, and results 
groups must also be created. This appendix describes how to make all of these settings modifications. 
 
1 Creation of new run modules 

 
1.1 Instrument procedures are controlled by the module manager. The control of operations such as injection 

time, oven temperature, voltage during electrophoresis, data collection interval and z-axis (not adjustable by 
user) can be modified. Modules must be created or modified from the templates provided. 

 
1.2 While setting up a new instrument computer, it will be necessary to create a new module. For use with the 

PowerPlex® 16 system, the module “PP16_5sec” will be used for a 5s injection. For a 2s injection, 
“PP16_2sec” will be used, and “PP16_10sec” will be used for the 10s injection.  

 
1.3 To create a new module, navigate to Instruments>ga3130xl>Module Manager in the tree pane view on the 

left side of the screen (in the Data Collection software) to open the Module Manager window as shown in 
Figure 1. Click on “New” and a Run Module Editor window appears.  

 
1.3.1 A previously made module can be exported from another computer and imported into the Module 

Manager rather than creating a new module, if desired. The import and export buttons are shown at 
the bottom of Figure 1.  

 

 
 

Figure 1. Module Manager. 
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1.4 Fill in the name and select the type of module (Regular) as well as a template 
(HIDFragmentAnalysis36_POP4) from the drop-down list. Make modifications to the run conditions as 
necessary to satisfy the run requirements. Figure 2 shows the conditions for the PP16_5sec run module. 

 

 
 

Figure 2. Run Module Editor. 
 

1.4.1 After the settings have been verified, save the new module by clicking “OK”. 
 

1.4.2 Similarly, a run module must be created for the 2 sec and 10 sec injections. To do so, click new at 
the “Module Manager” and repeat the above steps to create the modules entitled “PP16_2sec” and 
“PP16_10sec”. All settings should be as indicated in Figure y, except the injection time which 
should be 2 and 10, respectively. 

 
2 Creation of New Protocols 

 
2.1 The instrument protocol is used to tell the instrument all of the necessary run conditions for the sample, 

including the type of run, the run module, and the dye set. Typically, once a protocol is defined for a 
particular STR multiplex, it will be used repeatedly and it will not be necessary to create a new one. If a new 
protocol needs to be generated, proceed for directions. 

 
2.2 On the left side of the Data Collection Software, select GA Instruments>ga3130xl>Protocol Manager, as 

shown in Figure 3. 
 

2.3 In the Instrument Protocols section, click “New” to open the Protocol Editor and create a new protocol.  
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2.3.1 A previously-made instrument protocol can be exported from another computer and imported into 
the Protocol Manager rather than creating a new protocol, if desired. The import and export buttons 
are shown at the bottom of Figure 3.  
 

 
 

Figure 3. Protocol Manager. The solid arrow points to the appropriate selection 
on the menu at the left side of the screen. The dashed arrow (near middle) 

points to the “New” button for creating a new instrument protocol. 
 

2.4 Complete the Protocol Editor, as shown in Figure 4.  
 

 
 

Figure 4. Protocol Editor. 
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2.4.1 Type a name for the protocol. Typically, this names the amplification kit or dye set utilized for the 
samples of interest. 

 
2.4.2 Writing a description is optional. 

 
2.4.3 Select “Regular” in the “Type” drop-down list. 

 
2.4.4 Select the run module for your run. Typically, this will be: “PP16_5”, as this is the default run 

module for PowerPlex® 16. A custom run module may be desired (e.g., varying injection time, run 
time, etc.).  

 
2.4.5 Select the Dye Set for your samples. Typically, this will be “F”, which is the dye set for PowerPlex® 

16, PowerPlex® Y, Profiler Plus®, and COfiler®. 5-dye chemistries such as YfilerTM, IdentifilerTM, 
and MiniFilerTM typically utilize dye set G5.  

 
2.4.6 Click OK. 

 
2.4.7 Repeat the above steps to create an instrument protocol for each injection time (ex. PP16_2sec and 

PP16_10sec). 
 

3 New Results Groups 
 

3.1 The results group defines the file type, file name, analysis parameters, and file save location and run folder 
name preferences for the samples separated on the instrument.  

 
3.2 Prior to utilizing the Results Group Editor, make a folder, with the examiners initials for whom the Results 

Group folder will be created, in the appropriate folder on the E drive (shown in Figure 5). 
 

 
 

Figure 5. Making a folder for the Results Group. 
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3.3 Create a results group by clicking on “Results Group” in the Tree Pane and click on the “New” button, as 
shown in Figure 6. Alternatively, select a previously created results group to modify and click “Duplicate” 
and rename the results group. The results group editor, as shown in Figure 7, opens. 

 

 
 

Figure 6. Results Group listing. The solid arrow points to the appropriate selection on the menu 
at the left side of the screen. The dashed arrow (near bottom) points to the “New” button 

for creating a new results group, as described below. 
 

 
 

Figure 7. Defining the destination for the Results Group folder. 
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3.3.1 A previously made results group can be exported from another computer and imported rather than 
creating a new results group, if desired. The import and export buttons are shown at the bottom of 
Figure 6. 
 
Complete the general tab by entering a name for the results group and owner; the comment is not 
required 

 
3.3.1.1 Select the Analysis tab, choose “GeneMapper-3130xl_1” (or the name the instrument was 

assigned) as the analysis type, and ensure that Autoanalysis is not selected. 
 

3.3.1.2 Select the Destination tab, and choose a destination folder for the results. The default 
location is: E:\AppliedBiosystems\udc\datacollection\Data\Folder Name. Click “Use 
Custom Location” and browse to a location by clicking the “Browse” button (Figure 7). 

 
Select the Naming tab to customize sample file and run folder names.  

 
3.3.1.2.1 Sample file names may be formatted as: 

<WellPosition>_<SampleName>_<Plate Name>. Figure 8 shows how one 
would select this option in the Results Group Editor. A potential filename 
produced by the selection shown is: A01_AllelicLadder_2009-000.fsa 

 

 
 

Figure 8. Results Group Editor. An example of how run files and folders might be named is shown. 
 

3.3.1.2.2 In a similar manner, the run folder name format may be formatted as: <Plate 
Name>.fsa. Figure 8 shows how one would select this option in the Results 
Group Editor. An example of a run folder name is: 2009-000.fsa 

 
3.3.1.3 Select the Automated Processing tab and confirm that “only when the results group is 

complete” is selected. 
 

3.3.1.4 Click on “OK” to save the Results Group. This results group will be used during the 
sample data input in the Plate Manager. 

 
 
 

File Name 
Formatting 

Run Folder 
Name 
Formatting 
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4 New Size Standard 
 

4.1 In the GeneMapperTM ID software, choose “GeneMapper Manager” in the “Tools” pull-down menu. The 
GeneMapper Manager dialog box appears.  

 
4.2 Choose the “Size Standards” tab, as shown in Figure 9.  

 

 
 

Figure 9. GeneMapper Manager. Size Standards tab for creating new or editing 
an already existing size standard. 

 
4.3 Choose “New…” (near bottom of dialog box) to create a new size standard.  

 
4.3.1 Alternatively, a previously made size standard can be imported by choosing “Import…” 
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4.4 In the Size Standard Editor dialog box that opens, name the new size standard “ILS600” and enter the size 
standard dye (Red) and fragment sizes as shown in Figure 10. 

 
Note: The 60 and 80 bp fragments may be included or excluded from the fragments listed. Either 

choice will not affect the accurate sizing of the Amelogenin alleles since both the X and Y are 
larger than the 100 bp fragment. 

 

 
 

Figure 10. Size Standard Editor. Settings shown are those utilized for the ILS600. 
 

5 Analysis Method Editor 
 

5.1 In the GeneMapperTM ID software, select Analysis>Analysis Method Editor.  
 

5.2 Click on the “Peak Detector” tab. 
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5.3 Ensure that all selections are properly designated, as indicated in Figure 11. The size calling method used for 
the PowerPlex® 16 STR kit is the Local Southern method.  
 

 
 

Figure 11. Peak detector tab of the Analysis Method Editor. Only the analysis range 
and threshold for the red channel may be altered during data analysis. 

 
5.3.1 The analysis range starting and stopping points may be altered on a run-by-run basis to 

accommodate migration times that may vary between injections. Typically, a starting point of 3000 
and stopping point of 10,000 is appropriate. 

 
5.3.2 The values for the peak amplitude thresholds are based upon empirical data derived from the limit of 

detection analysis performed during the validation work and specific for each 3130xl instrument. 
While the ILS 600 (which uses the red dye) will have its default peak amplitude threshold set based 
on the LOD analysis, the threshold may be adusted upward, high enough to prevent detection of a 
known artifact present in the Promega ILS 600 size standard (Figure 4), or reduced when the ILS 
600 peaks may fall below the default threshold (this can occasionally occur with the 2 second 
injection). It is important to note that ONLY the Red dye (ILS 600 size standard) may be adjusted if 
such conditions are present.  
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5.4 The settings under the “Allele” tab should remain as shown in Figure 12. The Bin Set is defined as 
“Promega_Bins_ID3.2.0”. The cut-off value is set at “0.13” which represents a 13% global filter. Stutter cut-
off is set at 20% for all loci as indicated with the “0.2” setting in the “minus stutter ratio” row. Marker-
specific ratios are not used for convicted offender and arrestee samples and the box should remain unchecked.  

 

 
 

Figure 12. Analysis Method Editor – Allele Tab. The solid arrow points to where the bin set is defined.  
 

5.5 The default settings for the Peak Quality and Quality Flags tabs are used, as shown in Figures 13 and 14. 
 

5.5.1 Verify that the settings are the same as those shown in Figures 11 and 12, then click OK. 
 

    
 
 
 

 
 
 

Figure 13. Analysis Method Editor 
- Peak Quality Tab 

Figure 14. Analysis Method Editor 
- Quality Flags Tab 
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6 Panels and Bins 
 

6.1 Panels and bins must be created for allele calling of PowerPlex 16 data. In the GeneMapper ID software, 
navigate to “Tools” > “Panel Manager”. In the tree pane view on the left side of the dialog box (shown in 
Figure 15), choose “Panel Manager”.  

 

 
Figure 15. Panel Manager. 
 

6.2 Choose “File”>”Import Panels” and browse to the file on CD containing the panels for the PowerPlex 16 kit. 
Note: the panels need to be obtained from Promega, as they are not installed on the computer by Applied 
Biosystems.  

 
6.3 Navigate to “Promega_Panels_ID3.2.0” of the treepane view (at the left side of the screen), choose 

“File”>”Import Bins” and browse to the Promega bins file, typically entitled “Promega_Bins_ID3.2.0”.  
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6.4 Navigate to “Promega_Panels_IS3.2.0”> “PowerPlex_16_ID3.2.0” of the treepane view (at the left side of the 
screen). The resulting PowerPlex® 16 panel/bin set is shown in Figure 16. The marker specific stutter ratios 
must be updated to reflect the validation data obtained at VDFS. The new stutter ratios should be edited to 
reflect those shown in Figure 16. 

 

 
 

Figure 16. Panel/bin set for PowerPlex® 16. 
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6.5 To add commonly observed microvariant alleles to the bin set, click on the “+” of the 
“PowerPlex_16_ID3.2.0” of the treepane view to show all of the loci contained within the bin set, as shown 
in Figure 17. Click on the locus to which the allele will be added. The view screen changes to show the locus 
with all bins shaded in gray. Magnify the base pair area on the x-axis around the microvariant that will be 
added. Click on Bins>Add Bin. When the mouse is moved over the magnified bin view, there will be a 
vertical line that moves with the mouse. Place the line directly on the base pair value to be added and click. 
The box in Figure 18 will then appear. Name the allele under “Name”, check the base pair location of the 
allele and correct the value, if necessary. Define the left and right offsets for the allele bin and click the 
“mutant allele” box. Click “OK” and the allele is now added to the bin set. Repeat this procedure for alleles at 
other loci. The added MV allele bin will now appear with pink shading (as opposed to gray). 

 

 
 

Figure 17. Adding Microvariant bins to bin set. An arrow indicates an example of the selected locus 
which is then magnified. This example is shown using common microvariant allele D21S11 33.1 

 

 
 

Figure 18. Adding microvariants to bin sets. This box is used to set the parameters 
for the microvariant allele bin. 
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7 Plot Settings 
 

7.1 In GeneMapperTM ID, navigate to “Tools”>”GeneMapper Manager”. In the tabs near the top of the 
GeneMapper Manager dialog box, choose “Plot Settings” to create custom plot settings. Two different 
custom plot settings will be created: “Samples” and “Allelic Ladders”.  

 
7.2 Create a new plot setting by clicking “New” and the “Plot Settings Editor” will appear. In the “General” tab, 

type a name for the plot settings. In this instance, choose “Samples”.  
 

7.3 Figures 19 – 23 show the various tabs of the plot settings editor. Verify that the plot settings match those in 
the Figures below. 

 

 
 

Figure 19. Plot Settings Editor: Sample Header. 
 

 
 

 
 

Figure 20. Plot Settings Editor: Genotype Header. 

A 
 

B 
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Figure 21. Plot Settings Editor: Sizing Table. 
 

 
 

Figure 22. Plot Settings Editor: Labels. Note: these label settings are specific to the “Samples” plot settings. 
A second plot settings file will be created for allelic ladders in which the allele labels are different. 
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Figure 23. Plot Settings Editor: Display Settings. The arrows indicate the icons that must be clicked. 
 

7.3.1 Note that many of the settings in Figure 23 are difficult to discern from the figure because they are 
toggle switches. The icons to which an arrow is pointing must be clicked (once) for the appropriate 
settings. The number of panes may be set at the analyst’s discretion, but this is typically 2. 

 
7.4 Click OK. 

 
7.5 A duplicate Plot Setting shall be created for ease of printing allelic ladders. Create a new plot setting by 

clicking “New” and the “Plot Settings Editor” will appear. In the “General” tab, type a name for the plot 
settings. In this instance, choose “Allelic Ladders”.  

 
7.6 Figures 19-23 show the various tabs of the plot settings editor. Verify that the plot settings match those in the 

Figures. The only difference between the allelic ladder and samples plot settings is the allele label, as shown 
in Figure 24. For allelic ladders, only the allele call is used. 

 

 
 

Figure 24. Plot Settings Editor: Labels. Note that these label settings are specific 
to the “Allelic Ladders” plot settings. 
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	It is important to handle all samples aseptically to prevent contamination by extraneous DNA. It is also important to prepare databank samples in a separate lab space from casework samples to prevent possible cross-contamination.
	NOTE: For tracking purposes the samples will be listed on the worksheet in the order in which they were processed/handled. The samples will be maintained in the same order throughout the rest of the analysis. All samples will be processed in accordanc...
	Special Precautions:
	WARNING!


	CONVERSION FACTORS
	CONCENTRATIONS
	Concentration can be expressed several ways:
	Weight percent = (mass A/total mass of solution) x 100
	Volume percent = (volume A/total volume of solution) x 100
	Molarity (M): M = no. moles solute A/no. liters solution

	Examples:
	Prepare 50% solution of polyethylene glycol (PEG):
	Prepare 100 mL of 2M HCl from a stock solution of 12M HCl. (The question is how much stock solution of 12M HCl is needed?)



